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VY Important Power Information @&

To avoid damage to the CI.-U3 (and in some cases the connected equipment), it is important that you

follow the correct power sequence:

* Ifyou are using GPIO inputs, set the Differential Type switch (industrial models only) and I/O
Level switch (all models) BEFORE you connect equipment and BEFORE you apply power to the
CL-U3.

* Always power up the CL-U3 BEFORE the camera:
 Power up the CL-U3 and wait until it is fully powered (the Power/FPGA status LED is green).
+ Connect the camera to the CL-U3.

 Apply power to the camera.

* Always power down the camera BEFORE you power down the CL-U3.

Complete Power Information and Instructions

Table 1: Complete Power Information and Instructions

Models Power information and instructions

CL-U3B Important Overview: “Powering the CL-U3” on page 26
Order Codes: * “Differential Type and I/0 Level Switches” on page 22
903-0007, 903-0011 « “Powering the CL-U3B and CL-U3M Using USB 3.0” on page 26

Device Model Name:
iPORT-CL-U3-PTO3-CLOUP01-128x

CL-U3B-IND Important Overview: “Powering the CL-U3” on page 26

Order Codes: « “Differential Type and I/0 Level Switches” on page 22

903-0009, 903-0019, * “Powering the CL-U3B-IND and CL-U3M-IND Using an External Power Supply”
903-0013 on page 27

Device Model Name:
iPORT-CL-U3-PT03-CLOUP02-128x

CL-U3M Important Overview: “Powering the CL-U3” on page 26
Order Codes: * “Differential Type and I/0 Level Switches” on page 22
903-0008, 903-0012 « “Powering the CL-U3B and CL-U3M Using USB 3.0” on page 26

Device Model Name:
iPORT-CL-U3-PT03-CLOUP03-128x

CL-U3M-IND Important Overview: “Powering the CL-U3” on page 26

Order Codes: « “Differential Type and 1/0 Level Switches” on page 22

903-0010, 903-0020, * “Powering the CL-U3B-IND and CL-U3M-IND Using an External Power Supply”
903-0014 on page 27

Device Model Name:
iPORT-CL-U3-PT03-CLOUPO4-128x







WEnsuring Proper Image Streamingy
From a Camera Link Camera

Important: Before you attempt to stream images, you must know the image settings of your Camera Link

camera, and then configure the CL-U3 with matching image settings.
Steps to Ensure Proper Image Streaming

1. Ensure that you have installed Pleora’s eBUS SDK and supporting drivers on your computer. For
more information, see “Installing the eBUS Universal Pro Driver” on page 48.

2. Physically connect the camera, CL-U3, and computer. Power up the system. For more information,
see “CL-U3 Connections” on page 13.

3. Test the connection between the CL-U3 and the computer using the test pattern. For more
information, see “Confirming Image Streaming” on page 52.

4. You must now set up Camera Link serial communications to allow eBUS Player to communicate
with your camera. For more information, see “Accessing your Camera Settings through Camera
Link Serial Communications” on page 53.

5. After you have configured the image settings on the camera, you must then configure matching
image settings on the CL-U3. For more information about configuring CL-U3 settings, see
“Configuring CL-U3 Image Settings Using eBUS Player” on page 55.

The changes that you make to your CL-U3 are temporary and WILL NOT PERSIST ACROSS POWER CYCLES.
U Save your settings using the steps outlined in the section, “Saving eBUS Player and CL-U3 Settings” on page
69 to avoid losing changes when the CL-U3 is power-cycled.
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Chapter 1

About this Guide

This chapter describes the purpose and scope of this guide, and provides a list of complementary guides.
The following topics are covered in this chapter:

* “What this Guide Provides” on page 2
* “Documented Product Versions” on page 2
* “Related Documents” on page 3

+ “Further Reading” on page 3
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What this Guide Provides

This guide provides you with the information you need to connect the CL-U3 to Base or Medium

Camera Link cameras.

In this guide you can find product overviews, instructions for connecting the cables, installing the Pleora
eBUS™ SDK, establishing connections, performing general configuration tasks, and configuring the
settings to propetly capture and display images from Camera Link cameras. The last chapter of this guide

provides Technical Support contact information for Pleora Technologies.

Documented Product Versions

This guide covers the following product versions. The features and functionality documented in this

guide may vary if you are using an earlier or later version of the product.

Table 2: Documented Product Versions

Product Release/version documented in this guide...

iPORT CL-U3 External Frame Grabber 1.3.1

eBUS SDK and eBUS Player 6.1
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Related Documents

The iPORT CL-U3 External Frame Grabber User Guide is complemented by the following Pleora

Technologies documents, which are available on the Pleora Technologies Support Center

(supportcenter.pleora.com):

eBUS Player Quick Start Guide and eBUS Player User Guide, available for Windows, Linux, and
macOS

eBUS SDK API Quick Start Guides, available for C++, NET, Linux, and macOS

iPORT Advanced Features User Guide

Configuring Your Computer and Network Adapters for Best Performance knowledge base article
Introduction: Establishing a Serial Bridge knowledge base article

Updating Pleora Firmware knowledge base article

You can also consult the eBUS SDK API Help Files, which are installed on your computer during the

installation of the eBUS SDK. You can access this documentation from the Windows Start menu under

eBUS SDK.

Further Reading

Although not required in order to successfully use the CL-U3, you can find details about industry-related

standards and naming conventions in the following documents:

 USB3 Vision Standard, available from the Automated Imaging Association (AIA) at

www.visiononline.org.

 GenlCam Standard Features Naming Convention available from the European Machine Vision

Association (EMVA) at www.emva.org.

o Camera Link Standard, version 2.0 available from the Automated Imaging Association (AIA) at

www.visiononline.org.

o Pixel Format Naming Convention, available from the European Machine Vision Association

(EMVA) at www.emva.org.

About this Guide


http://www.emva.org
http://www.visiononline.org
http://www.visiononline.org
https://supportcenter.pleora.com/s/
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Chapter 2

About the iPORT CL-U3 External Frame Grabber

This chapter describes the CL-U3 External Frame Grabber, including the models and key features.
The following topics are covered in this chapter:

* “Models” on page 6
* “Feature Set” on page 10
» “Key GenlCam Features” on page 11

* “Available Pixel Formats” on page 12
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Models

The CL-U3 is available in several models and is equipped with the parts listed in the following tables.

Before assembly, ensure that all components are included in the selected package.

Table 3: Models
Order code Model Quantity

903-0007 iPORT CL-U3B External Frame Grabber in mountable enclosure
Device Model Name: iPORT-CL-U3-PTO3-CLOUP01-128x

iPORT CL-U3B External Frame Grabber in mountable enclosure for Camera Link 1
Base mode.

Note: No external power supply required.

903-0011 iPORT CL-U3B Development Kit

iPORT CL-U3B External Frame Grabber (903-0007) 1

Note: No external power supply required.

USB 3.0 cable 1
eBUS SDK USB stick 1
903-0009 iPORT CL-U3B-IND in mountable enclosure

Device Model Name: iPORT-CL-U3-PTO3-CLOUP02-128x

iPORT CL-U3B-IND External Frame Grabber in mountable enclosure for Camera 1
Link Base mode (industrial use).

* External power supply required. Order from Pleora Technologies using the
following part numbers: 904-3905 or 930-1904.
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Table 3: Models (Continued)

903-0019

iPORT CL-U3B-IND OEM board set
Device Model Name: iPORT-CL-U3-PT03-CLOUP02-128x

iPORT CL-U3B-IND External Frame Grabber OEM board set for Camera Link
Base mode (industrial use).

* External power supply required. Order from Pleora Technologies using the
following part numbers: 904-3905 or 930-1904.

USB 3.0 cable

eBUS SDK USB stick

903-0013

iPORT CL-U3B-IND Development Kit

iPORT CL-U3B-IND External Frame Grabber (903-0009)

Note: External power supply required and supplied.

Power supply

USB 3.0 cable

€BUS SDK USB stick

903-0008

iPORT CL-U3M External in mountable enclosure
Device Model Name: iPORT-CL-U3-PTO3-CLOUP03-128x

iPORT CL-U3M External Frame Grabber in mountable enclosure for Camera Link
Medium mode.

Note: No external power supply required.

903-0012

iPORT CL-U3M Development Kit

iPORT CL-U3M External Frame Grabber (903-0008)

Note: No external power supply required.

USB 3.0 cable

eBUS SDK USB stick

903-0010

iPORT CL-U3M-IND in mountable enclosure
Device Model Name: iPORT-CL-U3-PTO3-CLOUPO4-128x

iPORT CL-U3M-IND External Frame Grabber in mountable enclosure for Camera
Link Medium mode (industrial use).

* External power supply required. Order from Pleora Technologies using the
following part numbers: 904-3905 or 930-1904.

About the iPORT CL-U3 External Frame Grabber




Table 3: Models (Continued)

903-0020 iPORT CL-U3M-IND OEM board set
Device Model Name: iPORT-CL-U3-PT03-CLOUP04-128x

iPORT CL-U3M-IND External Frame Grabber OEM board set for Camera Link 1
Medium mode (industrial use).

* External power supply required. Order from Pleora Technologies using the
following part numbers: 904-3905 or 930-1904.

903-0014 iPORT CL-U3M-IND Development Kit

iPORT CL-U3M-IND External Frame Grabber (903-0010) 1

Note: External power supply required and supplied.

Power supply 1
USB 3.0 cable 1
eBUS SDK USB stick 1

iPORT CL-U3 External Frame Grabber User Guide



The following table illustrates the product models that are available.

CL-U3B: Standard model of the enclosed, mountable CL-U3 for Camera Link Base cameras

CL-U3B-IND: Industrial model, available in mountable enclosure or as a board set for Camera Link Base cameras

CL-U3M: Standard model of the enclosed, mountable CL-U3 for Camera Link Medium cameras

CL-U3M-IND: Industrial model, available in mountable enclosure or as a board set for Camera Link Medium cameras

About the iPORT CL-U3 External Frame Grabber



Feature Set

CL-U3B CL-U3M CL-U3B-IND  CL-U3B-IND CL-U3M-IND CL-U3M-IND
Order code 903-0007 903-0008 903-0009 903-0019 903-0010 903-0020
iPORT-CL-U3- |iPORT-CL-U3- |iPORT-CL-U3-PT03-CLOUPO2- iPORT-CL-U3-PT03-CLOUPO4-
Device Model Name PTO3- PTO3- 128x 128x
CLOUP01-128x |CLOUP03-128x
o Enclosed, Enclosed, Enclosed, OEM board set, |Enclosed, OEM board set,
Description standard use |standard use |industrial use |industrial use |industrial use  |industrial use
Camera Link mode Base Medium Base Base Medium Medium
Channels Single Single Single Single Single Single
MiniCL connectors 1 2 1 1 2 2
USB powered Yes Yes No No No No
PoCL No No Yes Yes Yes Yes
0°Cto45°C With PoCL off: | See note* With PoCL off: | See note*
: -40°Ct060°C -40°Cto 60°C
Operating temperature With PoCL on: With PoCL on:
-40°Cto 58°C -40°Ct0 58°C
Storage temperature -40°Ct0 85°C
DINEEE (ARGl 45x83x51 | 45x83x51 | 45x83x51 | 45x52x37 45x83x51 45x52 x 37
Weight (grams) Up to 137 Up to 137 Up to 137 Upto 42 Up to 137 Upto 42
GPIO - — 2 2 2 2
LVDS/RS-422/HVTTL/+24V/
+30V differential or TTL/LVCMOS
single-ended inputs
TTL/LVCMOS single-ended inputs J3 4 2 2 2 2
TTL/LVCMOS single-ended 3 3 3 3 3 3
outputs
MTBF at 40°C (hours) 1,135,333 1,135,333 958,332 958,332 958,332 958,332

Interface and transfer rate USB 3.0 interface with 3 Gb/s transfer rate

Standards compliance Compliant with Camera Link version 2.0 and USB3 Vision version 1.0

All enclosed units: FCC Part 15, subpart B, class B; CE; EN55032, EN55024; ICES-003; VCCI; RoHS2;

Regulatory compliance REACH. All board sets: RoHS2: REACH.

Camera Link Base models: 1 and 2 taps. Camera Link Medium models: 1, 2, and 4 taps.

Tap support

Pixel clock 20 MHz to 85 MHz pixel clock

Frame buffer 128 MB (120 MB is used for the frame buffer, 8 MB is used for the CL-U3 firmware)

1 UART on Camera Link interface for serial control of cameras using a computer application over the

Serial communication USB 3.0 connection

*Case and junction temperature limits vary by IC device. For more information, see “Ambient and Junction Temperatures” on page 33.

**Approximate, excluding 12-pin GPIO connector.
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Key GenlCam Features

The CL-U3 supports the seven features mandated by the USB3 Vision standard, along with many
additional features. The following table lists these mandatory features along with some of the key
GenICam features. The full list of features can be seen in the Device Control dialog box of Pleora’s eBUS
Player application.

Table 4: Key GenlCam Features

Feature Description

DeviceScanType Specifies the sensor scan type, such as areascan or linescan.
SensorDigitizationTaps Specifies the number of digitized samples output simultaneously by the camera.
WidthMax Specifies the maximum width of the image (in pixels).

HeightMax Specifies the maximum height of the image (in pixels).

Width Specifies the width of the image (in pixels).

Height Specifies the height of the image (in pixels).

OffsetX Specifies the horizontal image offset (in pixels).

OffsetY Specifies the vertical image offset (in pixels).

PixelFormat Specifies the format of the pixels provided by the camera.

ClConfiguration This Camera Link specific feature describes the configuration used by the camera.

ClConnectorSelector Selects the Camera Link interface to configure.

ClSafePowerActive Controls whether the SafePower protocol is active. SafePower is a protocol to prevent
the CL-U3 from attempting to supply power to a conventional (non-PoCL) cable or
camera.

ClSafePowerStatus Reports the status of the SafePower controller.

About the iPORT CL-U3 External Frame Grabber 11



Available Pixel Formats

The following table lists the pixel formats available on the CL-U3.

A The CL-U3M and CL-U3M-IND are the only models that support 4 taps.

Table 5: Available Pixel Formats

CL-U3B CL-U3M Pixel Formats

CL-U3B-IND  CL-U3M-IND

1, 2 taps 1, 2, 4 taps Mono8 (Default), Mono8s, Mono10, Mono10Packed, Mono12, Mono12Packed
1tap 1tap Mono14, Mono16

1, 2 taps 1,2, 4 taps BayerGRS, BayerRG8, BayerGB8, BayerBG8

1, 2 taps 1,2, 4 taps BayerGR10, BayerRG10, BayerGB10, BayerBG10

1, 2 taps 1,2, 4 taps BayerGR12, BayerRG12, BayerGB12, BayerBG12

1, 2 taps 1,2, 4 taps BayerGR10Packed, BayerRG10Packed, BayerGB10Packed, BayerBG10Packed
1, 2 taps 1,2, 4 taps BayerGR12Packed, BayerRG12Packed, BayerGB12Packed, BayerBG12Packed
1tap 1tap BayerGR16, BayerRG16, BayerGB16, BayerBG16

1tap 1tap RGBS, BGR8

No* 1tap RGB10

No* 1tap RGB12

1, 2 taps 1, 2, 4 taps SCFAIWGWR8

1, 2 taps 1, 2, 4 taps SCFAWGWR10

1, 2 taps 1, 2, 4 taps SCFAWGWR12

1tap 1tap SCFAIWGWR14

1,2 taps 1,2 taps YUV411_8_UYYVYY**

1tap 1tap YUV422_8_UYVY**

1tap 1tap YUV8_UYV**

1tap 1tap YCbCr422_8_CbYCrY**

1,2 taps 1,2 taps YCbCr709_411_8 ChbYYCrYY**

1tap 1tap YCbCr709_422_8 ChYCrY**

*Indicates unavailable pixel format.

** Available in release 1.3.1 (and later) of the CL-U3.
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Chapter 3

CL-U3 Connections

This chapter describes the CL-U3 connections, including connector details and pinout information. It

also includes information about how the CL-U3 receives power through cither the Micro-B USB3

connector or an external power supply, depending on the product model you are using.
When the CL-U3 is powered, you can observe the status LEDs.
The following topics are covered in this chapter:

+ “Connector and Switch Locations” on page 14

* “Micro-B USB 3.0 Connector” on page 16

¢ “Camera Link Connectors” on page 17

» “Mapping of Camera Link Connector and 12-Pin GPIO Connector Inputs” on page 18
* “12-Pin GPIO Connector” on page 19

« “Differential Type and I/O Level Switches” on page 22

* “Powering the CL-U3” on page 26

* “Power Consumption” on page 28

» “Status LEDs” on page 30

CL-U3 Connections
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Connector and Switch Locations

The following figures and table describe the CL-U3 connectors and switches.

Camera Link connector (CL1)

Camera Link connector (CL1)

Differential Type Differential Type
switch switch
Camera Link Camera Link
connector (CL2) connector (CL2)
1/0 Level switch I/0 Level switch
In mountable enclosure OEM board set
Example: iPORT CL-U3M-IND External Frame Grabber Example: iPORT CL-U3M-IND External Frame Grabber
USB 3.0 connector — USB 3.0 connector
12-pin GPIO — 12pin GPIO
connector connector
In mountable enclosure OEM board set

7 Depending on your product model, some connectors and switches may not be available.
-

Table 6: Connectors and Switches

Component Type Description
USB connector Micro-B USB 3.0 Connects a computer to the CL-U3 using a USB3 Vision connection.
connector

Compatible with USB 3.0 (SuperSpeed) connections.
For the standard models, supports power over USB 3.0.

For more information, see “Micro-B USB 3.0 Connector” on page 16.

GPIO connector 12-pin circular For the standard models, provides external signals, such as GPIO, to the CL-U3. For
connector the industrial models, provides power and also provides I/0 signals to the CL-U3.

For more information, see “12-Pin GPIO Connector” on page 19.
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Table 6: Connectors and Switches (Continued)

Component

CL1 connector

Type
Miniature Camera Link
(MiniCL) connector

Description

Provides connection to a Camera Link Base or Medium camera. Serial
communication on this connector is mapped to the BulkO serial communication
interface of the CL-U3.

This connector corresponds to Connector 1, as outlined in the Camera Link
Standard.

When PoCL is enabled, the industrial models can supply 4 W at 12 V to each Camera
Link connector, as outlined in the Camera Link Standard.

For more information, see “Camera Link Connectors” on page 17.

CL2 connector

Miniature Camera Link
(MiniCL) connector

Available only on the
Camera Link Medium
models

Provides connection to a Camera Link Medium camera to transmit images to the
CL-U3, using two Camera Link cables.

This connector corresponds to Connector 2, as outlined in the Camera Link
Standard.

When PoCL is enabled, the CL-U3M-IND can supply 4 W at 12 V to the camera, as
outlined in the Camera Link Standard.

For more information, see “Camera Link Connectors” on page 17.

Differential Type
switch

3-position DIP switch

Available only on the
industrial models

Selects the termination type for differential inputs.

For more information, see “Differential Type and |/0O Level Switches” on page 22.

I/0 Level switch

2-position DIP switch

Selects the voltage for single-ended GPIO inputs and outputs (3.3 V or 5 V).

For more information, see “Differential Type and |/O Level Switches” on page 22.

CL-U3 Connections
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Micro-B USB 3.0 Connector

The CL-U3 uses a Micro-B USB 3.0 connector for communication with your computer. For the standard

models, it also supplies power to the CL-U3.

USB 3.0 connector — USB 3.0 connector

In mountable enclosure OEM board set

For the industrial models, we recommend that you apply external power to the CL-U3 BEFORE you connect
o it to a USB port to ensure that adequate power is available.

. The CL-U3 uses a USB 3.0 Micro-B connector in an inverted configuration. For information about using
M locking cables with the inverted configuration, see “Using USB3 Vision Locking Cables with the Inverted
Micro-B USB 3.0 Connector” on page 90.

Locking Connectors

The CL-U3 supports the Micro-B locking connectors specified by the USB3 Vision Standard. The
enclosed CL-U3 models include threaded screw holes that comply with the connectors specified in the

standard.

Use a USB3 Vision cable and ensure that you secure the cable to the Micro-B USB 3.0 connector using the
V supplied locking screws.
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Camera Link Connectors

The CL-U3 supports Base or Medium Camera Link cameras (depending on your product model), which

stream image data to the CL-U3.

For the Camera Link Base models (the CL-U3B and CL-U3B-IND), the CL1 connector is used to
connect a Camera Link camera to the CL-U3 using one standard Camera Link cable, as outlined in the

Camera Link Standard. This connector can process up to 24 bits of data from the camera.

For the Camera Link Medium models (the CL-U3M and CL-U3M-IND), the CL1 and CL2 connectors
are used to connect a Camera Link camera to the CL-U3 using two standard Camera Link cables, as

outlined in the Camera Link Standard. These connectors can process up to 48 bits of data from the

camera.

All models provide the following Camera Link control signals on the CL1 connector, as outlined in the

Camera Link Standard: CC1, CC2, CC3, and CC4.

Camera Link connector (CL1)

___ Camera Link Camera Link
connector (CL2) connector (CL2)

Camera Link connector (CL1)

In mountable enclosure OEM board set
Example: iPORT CL-U3M External Frame Grabber Example: iPORT CL-USM-IND External Frame Grabber

Powering a Camera using Power Over Camera Link (PoCL)

The industrial models, which are powered through an external power supply, can optionally supply power

to the camera using PoCL, in accordance to the Camera Link Standard.

When powered using PoCL, the CL-U3B-IND can provide up to 4 W at 12 V to compatible cameras
through the Camera Link connector, while the CL-U3M-IND can provide up to a maximum of 8 W.

To enable PoCL and to prevent the CL-U3 from attempting to supply power to a non-PoCL cable or camera,
h*4 you must enable the ClSafePowerActive feature using eBUS Player (or an application created with the
eBUS SDK). For more information, see “Enabling SafePower and PoCL” on page 59.

When power is being supplied to the camera using PoCL, the PoCL1 and/or PoCL2 status LEDs will be

on. For more information about the status LEDs, see “Status LEDs” on page 30.
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Voltage Drop Monitoring

The CL-U3 includes a Voltage Dropped state that monitors a voltage drop from 12 V to a voltage below
10.5 V for cameras using PoCL. If the voltage drops below 10.5 V for more than 20 ms, the CL-U3

returns to the PoCL Sensing state.

For information about viewing the SafePower status and the status changes that occur, including PoCL

Sensing, see “Enabling SafePower and PoCL” on page 59.

Mapping to the Serial Communication Interface

The CL1 Camera Link connector is mapped to the BulkO serial communication interface on the CL-U3.

Mapping of Camera Link Connector and 12-Pin GPIO
Connector Inputs

The GPIO pins on the 12-pin GPIO connector allow an external signal to control a Camera Link camera,
and are typically used for triggering. For example, you can use a trigger to synchronize image capture from

multiple cameras or to synchronize image capture with an external device.
p Yy ge cap

12-pin GPIO 12-pin GPIO
connector connector

In mountable enclosure OEM board set

Using the Programmable Logic Controller (PLC), you can map and modify the GPIO input signals
(GPIO_IN3, GPIO_IN2, GPIO_IN1, and GPIO_INO) to:

* the camera control output signals (CC1, CC2, CC3, CC4) on the CL1 connector; and
« the GPIO output signals (GPIO_OUT2, GPIO_OUT1, GPIO_OUTO) on the 12-pin GPIO

connector.

There are 16 possible mappings of the GPIO signals. For more information, see “Handling GPIO,
Camera Control, and PLC Input and Output Programming Signals” on page 35.
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12-Pin GPIO Connector

The GPIO inputs and outputs on the 12-pin GPIO connector support a variety of differential and single-
ended inputs and outputs, such as HVTTL, LVDS, and LVCMOS. The available inputs and outputs
vary, depending on your CL-U3 model.

Table 7: Summary of Available Signals on the 12-Pin GPIO Connector
CL-U3B and CL-U3M CL-U3B-IND and CL-U3M-IND

(standard models) (industrial models)
Differential LVDS/RS-422/HVTTL/+24 V/+30 V inputs | N/A 2
(Can optionally be used as single-ended TTL/LVCMOS
inputs)
Single-ended TTL/LVCMOS inputs 4 2
Single-ended TTL/LVCMOS outputs 3 3
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12-Pin GPIO Connector Pinouts — Standard Models

The pinouts for the 12-pin GPIO connector on the standard models (CL-U3B and CL-U3M) are listed
in the following table.

&

», The manufacturer and part number are provided in “Material List” on page 90.

The mating connector is a Hirose 12-pin circular connector, part number HR10A-10P-125(73).

Table 8: 12-Pin GPIO Connector Pinouts — CL-U3B and CL-U3M

Pin Function Type PLC signal Notes

1 Reserved Reserved N/A Reserved, no connection
2 Reserved Reserved N/A Reserved, no connection
3 GPIO_IN3 Single-ended input Gpioln3

4 GPIO_0UT2 Single-ended output GpioOut2

5 GND/EMI_GND Ground N/A Signal ground

6 GPIO_IN2 Single-ended input Gpioln2

7 GPIO_OUT1 Single-ended output GpioOutl

8 GPIO_IN1 Single-ended input Gpioln1

9 GPIO_0OUTO Single-ended output GpioOutO

10 GPIO_INO Single-ended input GpiolnO

11 Reserved Reserved N/A Reserved, no connection
12 Reserved Reserved N/A Reserved, no connection
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12-Pin GPIO Connector Pinouts — Industrial Models

The pinouts for the 12-pin GPIO connector on the industrial models (CL-U3B-IND and CL-U3M-
IND) are listed in the following table.

4

» The manufacturer and part number are provided in “Material List”

on page 90.

The mating connector is a Hirose 12-pin circular connector, part number HR10A-10P-125(73).

Table 9: 12-Pin GPIO Connector Pinouts: CL-U3B-IND and CL-U3M-IND

Pin Function Type PLC signal Notes

1 RET Power return N/A Ground

2 VIN Power input N/A Protected by 600 W @ 1.0 ms
PP Zener TVS, +/- 30 kV per
KBM.
Receives 11.6 Vto 13V
unfiltered DC input, up to 1.1 A.

3 GPIO_IN1- Differential input1 negative | Gpiolnl Do not connect for single-ended
operation. Pin 6 provides the
single-ended connection.

4 GPIO_0OUT2 Single-ended output GpioOut2

5 GND/EMI_GND Ground Signal ground

6 GPIO_IN1+ Differential inputd positive Gpiolnl Can be used as a single-ended
input (optional).

7 GPIO_0OUT1 Single-ended output GpioOutl

8 GPIO_INO- Differential inputO negative | GpiolnO Do not connect for single-ended
operation. Pin 10 provides the
single-ended connection.

9 GPIO_OUTO Single-ended output GpioOutO

10 GPIO_INO+ Differential inputO positive GpiolnO Can be used as a single-ended
input (optional).

11 GPIO_IN3 Single-ended input Gpioln3

12 GPIO_IN2 Single-ended input Gpioln2
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Differential Type and |/0O Level Switches

The Differential Type switch (on the industrial models) and I/O Level switch (on all models) are used to
configure the CL-U3 to work with single-ended and differential inputs.

Differential Type switch Differential Type switch
I/0 Level switch I/0 Level switch
In mountable enclosure OEM board set
Example: iPORT CL-U3M-IND External Frame Grabber Example: iPORT CL-U3M-IND External Frame Grabber

Warning:

v To avoid damage to the CL-U3 and connected equipment (or reduced lifetime of the Differential Type
switch), ensure you observe the following precautions:

* Set the Differential Type and 1/0 Level switches BEFORE you connect equipment and apply power to
the CL-U3.

* Do not set the Differential Type switch to HVTTL when you are using LVDS equipment.

* Do not change the Differential Type switch setting while the CL-U3 is powered or while devices are
connected.
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The Differential Type switch, which is available on the industrial models, is used to select the differential

and single-ended signal levels.

HVTTL DIFF

LVDS

The I/0 Level switch is used to select either 3.3 VIVCMOS or 5 V TTL operation, and is used with
single-ended inputs and outputs.

3.3V 5V

The following table shows how the Differential Type and I/O Level switches can be set, based on the

input type.

Table 10: Switch Settings Based on Input Type

Input/output type

Set the Differential Type
switch to...

Set the I/0 Level switch
to...

Single-ended inputs and LVCMOS DIFF 3.3V

P T DIFF 5V
HVTTL/HVCMOS/HTL HVTTL N/A

Differential inputs LVDS LVDS N/A
RS-422 LVDS or DIFF N/A
+/-24V or +/-30 V DIFF N/A
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Differential and Single-Ended Input/Output Specifications

The input and output specifications vary, depending on how the Differential Type and I/O Level

switches are set, as listed in the following tables.

Warning:

To avoid damage to the CL-U3 and connected equipment (or reduced lifetime of the Differential Type

switch), ensure you observe the following precautions:

* Set the Differential Type and 1/0 Level switches BEFORE you connect equipment and apply power to

the CL-U3.

* Do not set the Differential Type switch to HVTTL when you are using LVDS equipment.

* Do not change the Differential Type switch setting while the CL-U3 is powered or while devices are

connected.

Table 11: GPIO Differential Input Specifications

Input type
Differential Differential Differential Differential used Differential
Specifications +/-24V, LVDS,RS-422  usedassingle- . o . usedas
+/-30V, with 100 Ohm ended HVTTL/ LVCM(g)S single-ended
RS-422 termination HVCMOS TIL
Differential input 10 Kand 100 Ohm N/A N/A N/A
termination 50 pFin
series
Single-ended 47 Kto 1/3 of I/0 level (1.1 V for Do not connect to negative (-) input
input 3.3VI/Olevelor1.7Vfor5V
termination I/0 level)
Negative (-)
input
Positive (+) 100 K to CL-U3 GND
input
Input thresholds -200 mV (minimum), differential <65V <0.9V <15V
Low -50 mV (typical), differential
0 mV (maximum), differential
High +200 mV (maximum), differential | >9.5V >1.3V >19V
+50 mV (typical), differential
0 mV (minimum), differential
Hysteresis 150 mV (typical)
Maximum delay 100 nsec 65 nsec 100 nsec 100 nsec 100 nsec
Mini
|n|mt.1m 30V
operation voltage
Mammym 130V
operation voltage
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Table 11: GPIO Differential Input Specifications (Continued)

Differential
+/-24V,

+/-
RS-422

Specifications

Clamping voltage

Input type

Differential Differential

Differential

Differential used

LVDS, RS-422
with 200 Ohm
termination

used as single-
ended HVTTL/
HVCMOS

Below -42 V, over +42 V

30V, LvCMOS

as single-ended

used as
single-ended
TIL

ESD protection

Up to class -4 (+/-15 kV)

EMI filtering

Serial ferrite bead 120 Ohm @ 100 MHz

Table 12: GPIO Single-Ended Input Specifications

Input type
Specifications
LVCMOS TTL
Termination 100 K to CL-U3 GND
Low threshold <0.8V <15V
High threshold >2.0V >35V
Maximum delay 8 nsec

Minimum voltage

-0.5 V (absolute)

Maximum voltage

6.5V (absolute)

ESD protection

Up to class -4 (+/-15 kV)

EMI filtering

Serial ferrite bead 120 Ohm @ 100 MHz

Table 13: GPIO Output Specifications

Output type

Specifications

LvCMoS TIL
High level output current +/-24 mA +/-32 mA
Output Voltage
High minimum 2.4V (@24 mA) 3.8V (@32mA)
High maximum 35V 5.3V
Low maximum 0.55V (@24 mA) 0.55V (@ 32 mA)

Maximum delay

6.4 nsec

ESD protection

Up to class -4 (+/-15 kV)

EMI filtering

Serial ferrite bead 120 Ohm @ 100 MHz
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Powering the CL-U3

\*4

Depending on the product model, you can power the CL-U3 in one of the following ways:

* Standard models (CL-U3B and CL-U3M). Powered using a USB 3.0 connection.
¢ Industrial models (CL-U3B-IND and CL-U3M-IND). Powered using an external power supply.

Powering the CL-U3B and CL-U3M Using USB 3.0

For the standard models, a USB 3.0 connection powers the CL-U3.

To power the CL-U3 over a USB 3.0 connection, 900 mA is required from the USB 3.0 port. Although
900 mA may not always be used, it is requested from the port.

If the host controller manages multiple ports and there are other devices that draw a large amount of power
(for example, another USB3 Vision device or a hard drive), the host controller may not grant the requested
900 maA, resulting in dropped images, dropped connection, or failure to connect. Similarly, on a USB hub,
ensure 900 mA is available for the port.

Important Power Sequence Information

To avoid damage to the CL-U3 (and in some cases the connected equipment):

* If you are using GPIO inputs, set the Differential Type and 1/0 Level switches BEFORE you connect
equipment and BEFORE you apply power to the CL-U3.

¢ Always power up the CL-U3 BEFORE the camera.

¢ Always power down the camera BEFORE the CL-U3.

To power the CL-U3B and CL-U3M using USB 3.0

1. Ensure that the Camera Link camera and the CL-U3 are NOT receiving power.
2. Securely connect the Camera Link cable to the camera and the CL-U3.
Ensure that you tighten the screws to prevent the camera from being disconnected accidentally.

Important: Do not disconnect the Camera Link cable while the camera or CL-U3 are receiving
power.

3. Connect the CL-U3 to a USB 3.0 port on your computer using a USB 3.0 cable.
4. Apply power to the camera using a power supply.

Important: The camera’s ground must be electrically floating or attached to a power supply that uses
the same ground as other attached USB 3.0 devices, such as the computer or a USB 3.0 hub.
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Powering the CL-U3B-IND and CL-U3M-IND Using an External Power
Supply

For the industrial models, power is supplied to the CL-U3 through the 12-pin GPIO connector with a
compatible power supply. For proper operation with both PoCL and non-PoCL cameras, 11.6 V to 13V

is required, with a minimum of 1.1 A.

External Power Supply — Input Signals

The following table lists the input power signals for the CL-U3B-IND and CL-U3M-IND from an
external power supply using the 12-pin GPIO connector.

Table 14: Input Signals from the 12-Pin GPIO Connector
Name Volts (V) Notes
VIN 11.6-13V Efficiency of power circuitry (including drops on Schottky diodes) is flat in this range.

Unfiltered DC power from an external power supply through the 12-pin GPIO connector.
Reverse voltage protected, up to-30 VDC.

The CL-U3B-IND and CL-U3M-IND generate all internal power rails from the VIN signal. A
resident common mode filter allows the input to be unfiltered, directly from a switching
wall plug power supply.

RET Ground Ground for VIN.

GND Ground 0V relative to other voltages on the CL-U3B-IND and CL-U3M-IND.

Important Power Sequence Information

To avoid damage to the CL-U3 (and in some cases the connected equipment):

* If you are using GPIO inputs, set the Differential Type and 1/0 Level switches BEFORE you connect
equipment and BEFORE you apply power to the CL-U3.

¢ Always power up the CL-U3 BEFORE the camera.
¢ Always power down the camera BEFORE the CL-U3.

We recommend that you apply external power to the CL-U3 BEFORE you connect it to a USB port.
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To power the CL-U3B-IND and CL-U3M-IND using an external power supply

1. Ensure that the Camera Link camera and the CL-U3B-IND/CL-U3M-IND are NOT receiving
power.

2. Securely connect the Camera Link cable to the camera and to the CL-U3B-IND/CL-U3M-IND3.
Ensure that you tighten the screws to prevent the camera from being disconnected accidentally.
3. Supply 12V power to the 12-pin GPIO connector on the CL-U3B-IND/CL-U3M-IND3.

Important: The 12 V power supply must use the same ground as other attached USB 3.0 devices,
for example, the computer or a USB 3.0 hub.

4. Connect the CL-U3B-IND/CL-U3M-IND to the computer using a USB 3.0 cable.
5. Apply power to the camera:

* If you plan on powering the camera using PoCL, use eBUS Player to enable PoCL (using the
ClSafePowerActive feature). For more information, see “Enabling SafePower and PoCL” on
page 59.

* If you are not powering the camera using PoCL, connect the camera to a power supply.

Power Consumption

The tables in this section outline the power consumption of the CL-U3. The measurements are based on
the use of the CL-U3 streaming video from the Vivid Engineering Camera Link Simulator CLS-212.

Table 15: CL-U3B Using Power from USB 3.0 Port

Pixel clock frequency  Sensor . . . Data rate Power
(MHz) digitization taps | Mioth | Helght | Pxel format (Mbps) (W)
20 2 4096 4096 MonoZ12Packed 476 1.7
85 2 4096 4096 Mono12Packed 2024 2.1

Table 16: CL-U3M Using Power from USB 3.0 Port

Pixel clockfrequency  Sensor . . . Data rate Power
(MHz) digitization taps Vot Height - Pixel format (Mbps) (W)
20 4 4096 4096 Mono8 630 1.7
85 4 4096 4096 Mono8 2543 2.3
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Table 17: CL-U3B-IND Power Consumption using External Power Supply*

External Bus
power supply measurement
Pixelclock  Sensor Data rate
frequency digitization  Width Height (Mbps) Power (W) Power (W)
(MHz) taps g
20 2 4096 4096 476 0.9 1.0 1.9
85 2 4096 4096 2024 1.2 11 2.3

*Using the Mono12Packed pixel format, with PoCL disabled.

Table 18: CL-U3M-IND using External Power Supply**

External Bus
power supply measurement
Pixelclock  Sensor .
frequency digitization :I‘\Qidt: 1: Height ?Ma;a ;)ate Power (W) Power (W)
(MHz) taps g ;
20 4 4096 4096 630 0.93 1.01 1.94
85 4 4096 4096 2543 1.16 1.14 2.30

**Using the Mono8 pixel format, with PoCL disabled.
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Status LEDs

The CL-U3 has status LEDs that indicate the operating status of the CL-U3’s USB controller, the
connection between the CL-U3 and the host computer, power, and firmware, as described in the

following figures and table.

For the industrial models, additional LEDs located beside the Camera Link connectors show the PoCL
status.

PoCL1 \

USB3

\ Power/FPGA

PoCL2
In mountable enclosure In mountable enclosure
Example: iPORT CL-U3M-IND External Frame Grabber All models
PoCL1 \
UsB3
T Power/FPGA
PoCL2 OEM board set
OEM board set All models

Example: iPORT CL-U3M-IND External Frame Grabber

7 Not all LEDs will be available, depending on your product model.
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Table 19: Status LEDs

LED Description

Power/FPGA Green: The CL-U3 is receiving power and the main firmware load is being used.
Green and orange: The CL-U3 is receiving power and the backup firmware load is being used.
For the industrial models, it can also indicate that you have not connected the USB cable to
the computer.
Off: The CL-U3 is not receiving power.

USB3 Yellow (flashing quickly): The CL-U3 is operating properly.

Yellow (flashing): Indicates GenCP traffic between the CL-U3 and the host.
Green (solid): A SuperSpeed (USB 3.0) connection has been established.
Off: A USB 2.0 connection has been established.

PoCL1, PoCL2

(available on the
industrial models)

Green: Power over Camera Link (PoCL) is active and the camera is being powered using PoCL.

Off: The camera is not receiving power through PoCL.
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Chapter 4

Ambient and Junction Temperatures

This chapter provides you with the information you need to ensure the optimal operating temperature

for your CL-U3B-IND and CL-U3M-IND OEM board set.

A You should store the CL-U3 at temperatures between -40°C to +85°C.
»

This chapter lists the components that consume the largest amount of power on the CL-U3 OEM board
set, and will therefore be most affected by high temperatures. You must provide a method to cool these

components using a heat sink or thermal pad.

Table 20: Thermal Guidelines, CL-U3B-IND and CL-U3M-IND OEM Board Set

Reference Component and

designator and manufacturer part Rating for component on standard Pleora product*
location number

U1, USB PHY Cypress ARM9 USB3 Ambient (under bias): -40°C to +85°C

board Controller

Junction: Not specified

Part number: Case: Not specified

CYUSB3014-BzXI
Junction-to-case thermal resistance 0JC: Not specified
Junction-to-ambient thermal resistance ©JA: Not specified
Power consumption: ~450 mW

U2, FPGA board ISSI DDR3 Ambient: Not specified
Part number: Junction: Not specified
IS43TR16640A-15GBLI Case: -40°C to +95°C

Junction-to-case thermal resistance ©JC: Not specified

Junction-to-ambient thermal resistance OJA: Not specified

Power consumption: ~ 260 mW at 2.5Gbps streaming
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Table 20: Thermal Guidelines, CL-U3B-IND and CL-U3M-IND OEM Board Set (Continued)

Reference Component and
designator and manufacturer part Rating for component on standard Pleora product*
location number
U4, FPGA board Altera FPGA Ambient: Not specified
Part number: Junction: -40°C to +100°C
B5CEFA4U19I7N

Case: Not specified

Junction-to-case thermal resistance 0JC: 5 (°C/W)
Junction-to-ambient thermal resistance OJA:

«  Still air: 23.6 (°C/W)

e 100 ft./min: 19.5 (°C/W)

* 200 ft./min: 17.5 (°C/W)

* 400 ft./min: 15.9 (°C/W)

Power consumption: ~ 880 mW

* ©JC = (Tj - Ta)/Prop, where Ptop = Power dissipation from the top of the package.

OJA = (Tc - Ta)/B, where P = Total power dissipation.
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Chapter b

Handling GPIO, Camera Control, and PLC Input and
Output Programming Signals

The CL-U3 includes a programmable logic controller (PLC) that lets you control external machines and

react to inputs. By controlling your system using the PLC, you can make functional changes, adjust

timing, or add features without having to add new hardware.

If your system includes a quadrature encoder, you can process its signals and produce trigger signals for

the camera using the CL-U3’s PLC, as described later in this chapter.

A For an introduction to the PLC and for detailed information about how PLC signals are handled, see the
l[_"-‘ iPORT Advanced Features User Guide, available on the Pleora Support Center at

supportcenter.pleora.com.

The following topics are covered in this chapter:

« “PLC Input and Output Programming Signals” on page 36
» “Using Quadrature Encoders” on page 38

« “Differential Connection” on page 39

 “Single-Ended Connection” on page 39

» “Processing Quadrature Encoder Signals” on page 40

Handling GPIO, Camera Control, and PLC Input and Output Programming Signals
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PLC Input and Output Programming Signals

The following table lists the PLC input and output programming signals and indicates the pins on which

they are available.

Table 21: PLC Signal Usage

Signal name

PLC equation usage

Associated pin on the 12-pin GPIO
connector

Camera Link connector

PbOFval In No associated pin
PbOLval In No associated pin
PbODval In No associated pin
PbOSpare In No associated pin
GpiolnO In Standard models: Pin 10 (GPIO_INO)
Industrial models*: Pin 10 (GPIO_INO+)
and 8 (GPIO_INO-)
Gpiolnl In Standard models: Pin 8 (GPIO_IN1)
Industrial models*: Pin 6 (GPIO_IN1+)
and 3 (GPIO_IN1-)
Gpioln2 In Standard models: Pin 6 (GPIO_IN2)
Industrial models*: Pin 12 (GPIO_IN2)
Gpioln3 In Standard models: Pin 3 (GPIO_IN3)
Industrial models*: Pin 11 (GPIO_IN3)
BufferWMO In No associated pin
GrbOAcgActive In No associated pin
PlcCtrl0 In No associated pin
PlcCtrl1 In No associated pin
PlcCtrl2 In No associated pin
PlcCtrl3 In No associated pin
PbOCCO In, out No associated pin CC1
PbOCC1 In, out No associated pin CC2
Pb0OCC2 In, out No associated pin CC3
PbOCC3 In, out No associated pin CC4
GpioOutO In, out Pin 9 on all models (GPIO_OUTO)
GpioOutl In, out Pin 7 on all models (GPIO_OUT1)
GpioOut2 In, out Pin 4 on all models (GPI0_0OUT2)
PlcFvalO In, out No associated pin
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Table 21: PLC Signal Usage (Continued)

Signal name

PLC equation usage

Associated pin on the 12-pin GPIO

connector

PlcLvalO In, out No associated pin
PlcMvalO In, out No associated pin
PlcTrig0 In, out No associated pin
PlcTimestampCitrl In, out No associated pin
TimerOTrig In, out No associated pin
TimerOOut In No associated pin
Timer4Trig In, out No associated pin
Timer1Out In No associated pin
Timer2Trig* In, out No associated pin
Timer20ut* In No associated pin
Timer3Trig* In, out No associated pin
Timer30ut* In No associated pin
CounterOReset In, out No associated pin
CounterOInc In, out No associated pin
CounterODec In, out No associated pin
CounterOEq In No associated pin
CounterOGt In No associated pin
Counter1Reset In, out No associated pin
Counterlinc In, out No associated pin
Counter1Dec In, out No associated pin
Counter1Eq In No associated pin
Counter1Gt In No associated pin
RescalerOIn In, out No associated pin
RescalerOOut In No associated pin
DelayerOln In, out No associated pin
DelayerOOut In No associated pin
EventO In, out No associated pin
Eventl In, out No associated pin
Event2 In, out No associated pin
Event3 In, out No associated pin

* Available in release 1.3.1 (and later) of the CL-GigE firmware.
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*For the full list of industrial models, see “Models” on page 6.

Using Quadrature Encoders

Quadrature encoder sensors produce electrical signals that indicate the direction, speed, and motion of
the processed material on the web or conveyor systems. These signals are often used to control camera
triggering to provide uniform images under varying load conditions. The quadrature encoder’s signals are

typically processed by an external frame grabber that produces a trigger signal for the camera.

Quadrature encoders have a solid or hollow shaft that is mechanically connected to a motor or rotating
apparatus on the web or conveyor system. Two-phase quadrature encoders have two outputs labeled A
and B, which produce square wave signals when the shaft is rotating. These signals are 90° out-of-phase.
When the shaft changes rotation between clockwise and counter-clockwise directions, these signals

change phasing between +90° and -90°.

Figure 1: Two-Phase Quadrature Encoder Signals

Forward Direction Reverse Direction

A L A L

B B ‘

This change is used to detect direction of motion. The rate of the square wave signals is proportional to
the rotation speed of the shaft. This change is also used for detecting speed of motion. When these signals

are steady-state, and are not producing square wave signals, the motion has stopped.

A For information about the electrical interface on the CL-U3, see “Differential Type and /0 Level Switches”
M‘ on page 22.

38

iPORT CL-U3 External Frame Grabber User Guide



Differential Connection

The following diagram illustrates a typical differential connection to a quadrature encoder.

Figure 2: Typical Differential Connection to Quadrature Encoder

Quadrature Encoder Ilndustri.;l Models
Differential Qutputs IDiﬂerentiaI Inputs

I

GPIO_IND+
A Pin 10 on 12-pin connector

T
Gpioln0
GPIO_INCG- I Terminationﬁ _I]-

A Pin 8 on 12-pin GP1O connector
|

B Pin & on 12-pin GPIO connector

| Gpiolnl
GPIO_IN1- I Termination _I:l- -

B Pin 3 on 12-pin GPIO connector

VV VYV

I
]
1
I
1
1
I
I GPIO_IN1+
|
I
|
|
|

Single-Ended Connection

The following diagram illustrates a typical single-ended connection to a quadrature encoder.

Figure 3: Typical Single-Ended Differential Connection to Quadrature Encoder

Quadrature Encoder Industrial Models
Single-Ended Outputs Differential Inputs
GPIO_INO+ |

_D A Pin 10 on 12-pin connector |
1

GPIO_INO- |
Pin 8 on 12-pin GPIO connector |

N/C |

Gpioln0

VREF

B Pin 6 on 12-pin GPIO connector

_l>

Gpiolnl
GPIO_IN1-

Pin 3 on 12-pin GPIO connector
n/c |

I
I
|
|
|
| GPIO_IN1+
|
I
|
|
I
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Processing Quadrature Encoder Signals

This section provides an example of how you can using the CL-U3’s PLC to process signals from a

quadrature encoder.
Example: Connect Gpioln0 and Gpioln1 to quadrature encoder outputs A and B, respectively.

In this example, images are captured only when the conveyor belt or web is moving in the forward
direction. When the conveyor belt or web moves in the forward direction, signal A leads signal B by 90°.
When the conveyor belt moves in the reverse direction, signal A lags signal B by 90°. The PLC provides
a trigger signal on the Camera Link control line PBOCCO only when signal A leads signal B by 90°.

The Timer0 function in the PLC is used to generate the trigger pulse Timer0Out. Timer0 itself is
triggered by the falling edge of a Boolean combination of A and B signals, which obtains the correct
quadrature phase for the forward direction. Another Boolean combination is used to produce the trigger
signal PbOCCO from signal B and Timer0Out; when the conveyor belt or web moves in the reverse

direction, signal B masks the trigger pulse Timer0Out.
Timer0 is configured with the following settings to generate a trigger pulse. These values may need to be

adjusted depending on the selected camera model and system requirements.

Table 22: PLC Timer Equations

Equation Description

TimerTriggerSource = Triggerlnput Sets the triggering source for the Timer to be its external trigger
input.
TimerTriggerActivation = FallingEdge Sets the Timer to trigger on the external source’s falling edge.

TimerGranularityFactor = Granularity30ns Sets the interval of the Timer’s internal clock tick. For this example,
we recommend that the selected factor be at least 8x smaller than
the period of the highest frequency expected from the quadrature
encoder.

TimerDelayRaw = 1 Sets the delay time before the pulse can start. This is the low period
of the pulse after the trigger. This value represents the number of
Timer internal clock ticks.

TimerDurationRaw = 6 Sets the duration or high time of the pulse. This value represents the
number of internal clock ticks.
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The signal routing block in the PLC is configured using the Boolean expressions below. Gpioln0 is signal

A and Gpiolnl is signal B. Note that "!" in the Boolean expressions represents 7oz or inverted.

Table 23: Signal Routing Block Equations

Equation
TimerOTrig = Gpioln0 & !Gpioln1

Description

Generates the trigger signal for Timer0 from signals A and B.

PbOCCO = !(TimerOOut & Gpioln0Q)

Masks the trigger for the camera when the conveyor belt or web

moves in the reverse direction.

The following table provides recommendations for using quadrature encoders with the industrial models.

Table 24: Quadrature Encoder Recommendations

Encoder output type Encoder output GPIO input Notes
Differential A Differential InputO positive, PLC signal name: GpiolnO
pin 10 on the 12-pin connector
A Differential InputO negative,
pin 8 on the 12-pin connector
B Differential Inputd positive, PLC signal name: Gpioln1l
pin 6 on the 12-pin connector
B Differential Input1 negative,
pin 3 on the 12-pin connector
Single-ended A Differential InputO positive, PLC signal name: GpiolnO
pin 10 on the 12-pinconnector | - p¢rerential InputO negative, pin
8 is not connected
B Differential Input1 negative, PLC signal name: GpiolnO
pin 6 on the 12-pin connector Differential Input1 negative, pin
3 is not connected
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Chapter 6

Bulk Interfaces

The CL-U3 has one UART interface for serial communication with a connected Camera Link camera.
The following topics are covered in this chapter:

* “GenlCam Interface for Serial Communication Configuration” on page 44

e “UART Timing” on page 44
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GenlCam Interface for Serial Communication Configuration

The following GenICam features are available for serial communication configuration.

Table 25: GenlCam Features Available for Serial Communication

Feature Description

BulkSelector Selects BulkO for configuration.

BulkBaudRate Selects a predefined Baud rate or programmable option.

BulkBaudRateFactor Programs a user-defined Baud rate.

BulkLoopback Loops back downstream data to upstream direction (loops the data back to the
computer).

BulkNumOfStopBits Selects a stop bit option (either 1 or 2).

BulkParity Selects a parity option (None, Even, or Odd).

BulkUpstreamFifoWatermark Controls the number of bytes to accumulate in the Bulk interface upstream FIFO
before the CL-U3 delivers them to the host using an event type packet.

UART Timing

The UART interface supports:

* 8-bit data transfer

* 1 start bit

¢ Programmable stop bit(s): 1 or 2 stop bits
¢ Darity: None, Even, or Odd

* Baud rates:

¢ DPredefined rates: 9600, 14 400, 19 200, 28 800, 38 400, 57 600, 115 200, 230400*, 460800*,
and 921,600*

+ Programmable

¢ Loop back mode from downstream to upstream

*Available in release 1.3.1 (and later) of the CL-U3 firmware.

Figure 4: UART Timing

44 iPORT CL-U3 External Frame Grabber User Guide



A number of preset baud rates can be used. If you require a baud rate that is not covered by the presets,

you can specify your own baud rate. To specify your own baud rate:

1. In the Device Control dialog box, under Port Communication, choose Programmable in the
BulkBaudRate list.

2. In the BulkBaudRateFactor field, enter a baud rate between 1 and 511.

The CL-U3 calculates the baud rate using the following equation:
(66.666666 MHz * 1000000)/(BulkBaudRateFactor * 16)

*Available in release 1.3.1 (and later) of the CL-U3.

Table 26: UART Baud Rates

Baud rate, BR (bps) Notes

9,600 Preset O (default)
14,400 Preset 1

19,200 Preset 2

28,800 Preset3

38,400 Preset4

57,600 Preset5
115,200 Preset 6
230,400* Preset 7
460,800* Preset8
921,600* Preset 9
Maximum BulkBaudRateValue (when BulkBaudRateFactor is set to 1): 4,166,667 | Programmable baud rate
Minimum BulkBaudRateValue (when BulkBaudRateFactor is set to 511): 8,154

*Available in release 1.3.1 (and later) of the CL-U3.

The following table provides the A.C. operating characteristics of the UART interface.

Table 27: A.C. Operating Characteristics of the UART Interfaces

Parameter Symbol Min Max Units Notes
Data period tUART 0.240 122.64 us
Baud rate BR 8154 4166 667 bps 1/tUART

Bulk Interfaces

45







Chapter 7

Installing the eBUS SDK

This chapter describes how to install the eBUS SDK, and also provides information about installing the

required driver.

A Before you can configure and control your CL-U3, you must install the eBUS SDK and USB3 Vision driver.

The following topics are covered in this chapter:

¢ “Installing the eBUS SDK” on page 48
¢ “Installing the eBUS Universal Pro Driver” on page 48
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Installing the eBUS SDK

You can install the Pleora Technologies eBUS SDK on your computer to configure and control your

CL-U3.
The eBUS SDK includes:

¢ DPleora’s eBUS Player application, which allows you to control the CL-U3 parameters and view video
from a video source connected to the CL-U3.

* An extensive library of sample applications, with source code, to create working applications for
device configuration and control, image and data acquisition, and image display and diagnostics.

¢ Drivers that optimize the performance of your system.
It is possible for you to configure the CL-U3 and USB3 Vision compliant video sources using other

GenlCam compliant software, however, this guide provides you with the instructions you need to use the

Pleora eBUS Player application.

Installing the eBUS Universal Pro Driver

&

The eBUS SDK includes a USB3 Vision driver that allows for configuration and control of USB3 Vision
devices. The driver must be installed before you can use eBUS Player or any third-party SDK software to

configure the CL-U3. If it is not installed, the software will not detect the CL-U3.

~ The GigE Vision driver, which is available during the installation of the eBUS SDK, is for use with GigE Vision
=l devices, such as the Pleora CL-GigE External Frame Grabber. The driver enhances existing general-purpose

drivers shipped with NICs, increases image acquisition throughput and performance, decreases latency
and jitter, and minimizes CPU utilization.

The drivers are selected for installation by default during the eBUS SDK installation process. If you choose
not to install the drivers (or want to uninstall either driver), you can use the eBUS Driver Installation Tool.
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To use the eBUS Driver Installation Tool

1. Click Start > All Programs > eBUS SDK > eBUS Driver Installation Tool.
2. UnderUSB3 Vision, click Install or Uninstall.

After a moment the driver status changes. If you are installing a driver, the driver is installed across
all USB3 Vision devices on your computer.

3. Close the eBUS Driver Installation Tool.

You may be required to restart your computer.

To see the versions of the installed drivers, click Help > About.
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Chapter 8

Connecting to the CL-U3 and Configuring General
Settings Using eBUS Player

After you have set up the physical connections to the CL-U3, you can start eBUS Player to configure

image settings, which will help ensure that images are received and displayed properly. You can also

configure the buffer options to reduce the likelihood of lost packets.

v BEFORE you attempt to stream images, you must know the image settings of your Camera Link camera,
and then configure the CL-U3 with matching image settings.

The following topics are covered in this chapter:

+ “Confirming Image Streaming” on page 52

» “Accessing your Camera Settings through Camera Link Serial Communications” on page 53
+ “Configuring CL-U3 Image Settings Using eBUS Player” on page 55

+ “Enabling SafePower and PoCL” on page 59

* “Viewing and Testing Streaming Images” on page 61

 “Configuring the Buffers” on page 62

* “Calculating the Required Bandwidth” on page 63

» “Specifying How Images are Acquired” on page 64

¢ “Recording and Retrieving Images in the Onboard Memory” on page 66

* “Implementing the eBUS SDK” on page 68

Connecting to the CL-U3 and Configuring General Settings Using eBUS Player
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Confirming Image Streaming

After the CL-U3 is physically connected to the computer, use eBUS Player with the test pattern feature

enabled to verify that the CL-U3 can stream properly to the computer.

After you have confirmed that eBUS Player is receiving the test pattern from the CL-U3, disable the test

pattern so that the CL-U3 can stream images from the camera.

For detailed instructions about how to use eBUS Player, see the eBUS Player for Windows and Linux User
Guide available on Pleora’s Support Center at supportcenter.pleora.com.

To start eBUS Player and connect to the CL-U3

P W bR

Start eBUS Player from the Windows Start menu.
Click Select/Connect.
In the Device Selection dialog box, click the CL-U3 and then click OK.

Under How is your camera powered, your selection will vary depending on the CL-U3 model:

* Standard models (CL-U3B and CL-U3M). Click My camera has an external power supply
(these models do not support PoCL).

* Industrial models (CL-U3B-IND and CL-U3M-IND). Click either option, depending on how

you are powering your camera.

When you select Power is provided by the frame grabber Camera Link cable (PoCL), the
ClSafePowerActive feature* is set to True.

* The ClSafePowerActive feature enables the SafePower protocol on the CL-U3 so it can supply
power using PoCL. This protocol also prevents the CL-U3 from attempting to supply power to
a camera that does not support PoCL.

Click OK.
eBUS Player is now connected to the CL-U3.

To turn the test pattern on or off

1.

Start eBUS Player and connect to the CL-U3.

For more information, see “To start eBUS Player and connect to the CL-U3” on page 52.

2. Under Parameters and Controls, click Device Control.

3. Under ImageFormatControl, click a test pattern option in the TestPattern list.

4. Close the Device Control dialog box.
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5. When the test pattern is enabled and you click Play, you will see an image similar to this (the pattern
and colors may vary, depending on the image settings).

Accessing your Camera Settings through Camera Link Serial
Communications

You can use eBUS Player to send serial commands between the CL-U3 and the Camera Link camera. For

a list of commands that can be sent to the camera, consult the camera’s technical documentation.

7y This section explained how to send serial commands between the CL-U3 and the camera. Alternatively, you
lE’ can establish a serial bridge or camera bridge to communicate with your camera using serial
communication.

The following options are available:
¢ GenCP communication, for cameras that are GenCP compliant.

* Serial port (COM port) communication, which you will use if your camera manufacturer has provided a
software application that assumes that you use a serial port on your computer to send serial
commands to the camera.

e Camera Link DLL, which you will use if your camera manufacturer has provided a software application
that uses a Camera Link DLL to send serial commands to the camera.

* GenlCam CLProtocol library, which you will use if you have a CLProtocol DLL (provided by the camera
manufacturer).

For information about using these serial communication methods, see the knowledge base article titled
Introduction: Establishing a Serial Bridge on the Pleora Support Center at supportcenter.pleora.com.
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To send serial commands to your camera using eBUS Player

1. Start eBUS Player and connect to the CL-U3.

2. On the Tools menu, click Device Serial Communication.

8.
9.

File = Tools Help
Cor Setup...

Default GigE Vision Communication Parameters...

Default USB3 Vision Cornmunication Parameters...

Pz

T Event Monitor
GigE Vision Action Command...

GUI
Device Serial Communication...

Ven - |/\\:
Frame Grabber Camera Bridge...

Mot Serial Communication Bridge...

In the Port Selection list, ensure the bulk port is selected.
In the Speed list, select the baud rate that matches your camera.

Tip: If you need to set the parity and stop bits, click Device control on the main page of eBUS
Player. In the Visibility list, click Guru. Under IP Engine > PortCommunication, set the values for
these options.

Under Send as, select the data transmission sequence format by clicking either ASCII (text only) or
Hexadecimal.

Device Serial Communication *
Port Selection
Port Bulko w Speed Baud3600 w [JLoopback
Send
Send as @asct (O Hexadecimal
Data | gq::l Send
Append crR [iF [Onow  [[other

Send From File

File | Send file

[ Loopback validation

Transcript
Display format (@) ASCII (O Hexadecmal () Hybrid Echo sent data Clear

Type the data string in the Data box.

For hexadecimal, enter a pair of hexadecimal digits for each byte, separated by spaces. For example,

01234567 89 AB CD EE
Select one of the trailer options beside Append.
Trailer options are not mutually exclusive; they append in the order shown.

Select Other for ASCII and hexadecimal sequences in custom trailers for devices that do not use the
trailer options in the order shown, for example, CR and LE.

Click Send to transmit the data sequence.

Wait for the device to reply.

10. Close the Device Serial Communication dialog box.
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Configuring CL-U3 Image Settings Using eBUS Player

After you have configured your Camera Link Camera with optimal image settings, you must configure

matching image settings on the CL-U3.

The changes that you make to your CL-U3 are temporary and will not persist across power cycles. To
V understand more about how to save your settings, see “Saving eBUS Player and CL-U3 Settings” on page

69.

Take note of the camera’s image settings

Take note of the camera’s image settings. You can find this information by consulting the camera’s

technical documentation or by using the camera configuration software that accompanies your camera.

Scan type (area scan or line scan)

Number of taps (sometimes referred to as tap geometry or sensor digitization taps)
Image width

Image height

Pixel bit depth (8, 10, 12 bits, or more)

Pixel format

These settings may not be available in the software; you may need to use the camera’s technical
documentation to find this information. If you cannot find the pixel format, you should start by
configuring the CL-U3 to use a Mono (monochrome) setting.

Power source (from a power supply or PoCL)

To ensure the CL-U3 is streaming images properly, you must configure the CL-U3’s image settings to

match those previously configured on the camera.
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Supported Device Tap Geometries for the CL-U3

The following table lists the supported device tap geometries for the CL-U3. Please note that the CL-U3

does not support tap reconstruction for the supported tap geometries (that is, the taps are received in

order from the camera).

Table 28: Supported Camera Link Tap Geometries

Tap geometry Number of taps Scan type
CL-U3B, CL-U3B-IND, CL-U3M, and CL-U3M-IND

Geometry_1X_1Y 1 Areascan
Geometry_1X2_1Y 2 Areascan
Geometry_1X 1 Linescan
Geometry_1X2 2 Linescan
CL-U3M and CL-U3M-IND

Geometry_1X4_1Y 4 Areascan
Geometry_1X4 4 Linescan

» If your camera outputs a tap geometry that is not listed in Table 28, you may need to perform tap

reconstruction using your software application. For more information about tap geometry, refer to the
GenlCam Standard Features Naming Convention (Version 2.0 or later), available from the European

Machine Vision Association at http://www.emva.org.
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To configure image settings on the CL-U3

1. Start eBUS Player and connect to the CL-U3.

For more information, see “To start eBUS Player and connect to the CL-U3” on page 52.

2. In the Visibility list, click Expert.

3. Under DeviceControl, select a sensor scan type (areascan or linescan) in the DeviceScanType list.

Frame Grabber Control

B *:

FraicaiCar™Dlareinnblinee n

Device Scan Type
Scan bype of the sensor of the device,

Feature Name: DeviceScanType
Type: Enumeration

Mame Space: Standard

isibility: Expert

Streamable: True

Areascan

=) DeviceControl
DeviceScanType Areascan ~
DeviceVendorMame
DeviceModelName
DeviceFamilyhame IPORT CL-LI3
DeviceManufacturerInfo PORT-CL-U3-PTO3-CLOURDS
DeviceYersion Wersion 1.0
DeviceFirmwarei'ersion 1.o01.01.01
DeviceSerialMumber 01523041
DevicellserID
DeviceSFMCYersionMajor 2
DeviceSFMCYersionMinor 1
DeviceSFNCYersionSubMinar o
DeviceTLVersionMajor 1
DeviceTLYersionMinar o
DeviceGenCPYersionMajor 1

*

visitiliey | Expert v x
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4. Under ImageFormatControl, select the number of taps in the SensorDigitizationTaps list.

Note: In release 1.0.1, turning on the TestPattern substantially limits the number of available pixel
formats. In 1.3.1 and later, there is no impact to the number of available pixel formats.

Frame Grabber Control

+ DeviceControl

= ImageFormatControl

SensorDigitizationTaps e
WidthiMaz One
HeightTa
“Wwidth
Height 430
Offseti ]
Offsety ]

PixelFormat Monod

PixelSize Bpp&
PixelColorFilker Mone

TestPattern iPORTTestPattern
+ AcquisitionControl
+ DigitalIDControl

+ EventControl

L TwancnaeH avarCankenl

Sensor Digitization Taps

Mumber of digitized samples outputted simultaneously by the camera AfD
conversion stage.,

Feature Name: SensorDigitizationTaps
Type: Enumeration

Mame Space: Standard

isibility: Expert

Streamable: True

*

Us 9 visibility | Expert - x

configuration is valid.

», DeviceScanType, SensorDigitizationTaps, PixelFormat, and TestPattern are interrelated. When you
lE’ change any of these values, the CL-U3 may automatically adjust the other values to ensure the

5. Under ImageFormatControl, enter the image width and height, and select a pixel format from the

PixelFormat list.
6. Close the Device Control dialog box.
Click Play to see the changes.
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Enabling SafePower and PoCL

The industrial models can supply power to one Camera Link Base or one Camera Link Medium camera
(depending on your model), using PoCL. When you use PoCL, power is supplied over one standard
Camera Link cable (for Camera Link Base models) or two standard Camera Link cables (for Camera Link

Medium models), as outlined in the Camera Link Standard.

To allow the industrial models to supply power to Camera Link cameras using PoCL, enable the
ClSafePowerActive feature. When this feature is enabled, PoCL is active and the SafePower protocol is

used, which prevents the CL-U3 from attempting to supply power to a non-PoCL cable or camera.
To enable SafePower and PoCL and to view the PoCL status (industrial models only)

1. Start eBUS Player and connect to the CL-U3.
For more information, see “To start eBUS Player and connect to the CL-U3” on page 52.
2. In the Visibility list, click Expert or Guru.

3. Under CameraLinkInterfaceControl, select a connector in the ClConnectorSelector list. See the
table below for connector selection information.

4. In the ClSafePowerActive list, click True to enable SafePower and PoCL.

Table 29: Connector Selection for Enabling Camera Link SafePower

CL-U3 model CiConnectorSelector list item CL-U3 connector
CL-U3B-IND Connectorl CL1
CL-USM-IND Connectorl CL1

Connector2 CL2
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5. Review the status that appears under ClSafePowerStatus. The following flowchart explains the
status changes. Please note that each connector performs this process independently.

Initializing.
The detection of a PoCL
camera and cable has not
started yet.

!

PoClISensing.
The CL-U3 is determining if a

» PoCL camera and cableare
connected.
What type of camera/cable
is detected?
l—Non—PoCL | PoCL l
Status changes to Status changes to
NonPoCliCameraOrCableDetected. PoCIiCameraAndCableDetected.
No \ Pixel clock Pixel clock \ No
{ ° detected detected 0
| |
Timeout? Yes Yes Timeout?
Status changes to Status changes to
;;4, NonPoClLinkUp PoClLinkUp I—A
— and CL-U3 and CL-U3 <
continues to detect 4—‘ continues to detect
pixel clock. pixel clock.
Yes Yes
No l No
Pixel clock Pixel clock
No detected detected No
Timeout? Timeout?
L—Yes —l I—Yes |
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Viewing and Testing Streaming Images

You can view and test your image settings using eBUS Player.

To view images from the camera, the test pattern must be disabled. For more information, see “To turn the
test pattern on or off” on page 52.

To view streaming images in eBUS Player

1. Start eBUS Player and connect to the CL-U3.
For more information, see “To start eBUS Player and connect to the CL-U3” on page 52.

2. Under Acquisition Control, select the acquisition mode you want to use to acquire images. By
default, images are streamed in Continuous mode (the CL-U3 sends a stream of continuous images
instead of a single image).

For other acquisition modes, see “Specifying How Images are Acquired” on page 64.

3. Click Play.

The images appear in the Display section of eBUS Player.

Example image. When the test pattern is enabled for the CL-U3, a stream of moving lines will appear
(often black, gray, and white) instead of video from your camera.

7y If images or the test pattern do not stream, see the tips provided in “System Troubleshooting” on page 75.
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Configuring the Buffers

You can increase the buffer count using eBUS Player to make streaming more robust. A high number of
buffers are needed in high frame rate applications, while a small number of buffers are needed for lower

frame rates. Latency increases as the number of buffers increases.
To configure the buffers

1. Start eBUS Player.

2. Click Tools > Buffer Options.

3. Click the buffer option that suits your requirements.
4. Click OK.

Buffer Options *

Buffers used For streaming
Increasing the buffer count can make streaming more tolerant to

buffers  missing black IDs, but at the expense of using more memory and

increasing latency,

Using more than 16 buffers is bypically used in high frame rate,
small buffer size applications.

Applications using low frame rates or using very large buffers are
nok as sensitive to missing block IDs and can thus save memory
and latency by only using 4 or & buffers,

Default buffer size
The default buffer size is used to allocate acquisition pipeline

4147200 bytes buffers when it is not possible to read the payload size directly
From the device.

The default buffer size can be calculated using this Formula:
({{width * pixel bytes) 4+ padding x) * height) + padding v.

Automatic buffer resizing

If enabled, buffers are automatically resized by the acquisition
W ,
Epabled pipeline when the BUFFER_TOO_SMALL operation result is
returned.

Cancel

A Default size for streaming is 16 buffers.
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Calculating the Required Bandwidth

When using the CL-U3 and connected Camera Link camera, you may observe high data rates.

To calculate the approximate bandwidth that is required, use the following formula. Keep in mind that
this calculation results in an approximate value, and does not take into account USB3 Vision overhead.

Note that each image is broken up into many packets, which should be considered when determining

overhead.

A PayloadSize is automatically calculated by the CL-U3, based on the selected image settings, which include

M Width, Height, OffsetX, OffsetY, PixelSize, and any padding that has to be added to the image payload. To

see the PayloadSize, open eBUS Player, connect to the CL-U3, and then click Device control. PayloadSize
appears in the TransportLayerControl category.

For example, for a CL-U3 configured with 1280 x 720, a 16-bit pixel format, and a PayloadSize of
1.84 MB at 60 frames per second, the equation would look like this:

1.84 MB x 8 x 60 Hz = 883.2 Mbps
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Specifying How Images are Acquired

Continuous, SingleFrame, and MultiFrame modes are usually standard for external frame grabbers.

Acquisition starts when the Play button is pressed (the AcquisitionStart command is executed).

o

GUID

Vendor

Model

Mame

Source

Mode

Parameters and

O <BUS Player
File Tools  Help

Connection
Select | Connect Disconnect
IP address M

MAC address HiA

Z8B701523041
Fleora Technologies Inc.

IPORT-CL-US-PTOS-CLOUPO4-125xL

Acquisition Control

Continuous ~

Continuous
P [singleFrame
Flay
ContinuousRecording

ContinuousReadout
SingleFrameRecording
SingleFrameReadout

MultiFrameRecording

eBUS Player Main Page

», The acquisition modes supported by the CL-U3 are enumerated by the GenApi AcquisitionMode feature.

*

Frame Grabber Control

E‘:EE E‘§ Wisibility | Beginner w x
DeviceControl
ImageFormatControl

1= AcquisitionControl

AcquisitionfMode Conkinuous ~
AcquisitionFrameCount Continuous
AcquisitionFrameToSkip SingleFrame

EventControl ContinuousRecording

TransportLayerControl ContinuousReadout
UserSetControl SingleFrameRecording

- i i SingleFrameReadout

PixelBusInterfaceControl MultiFrameRecording
iPORTEngine
CameralLinkInterfaceControl
Acquisition Mode ~

Sets the acquisition mode of the device. It defines mainly the number of
frames to capture during an acquisition and the way the acquisition stops,

Feature Mame: AcquisitionMode
Type: Enumeration

Mame Space: Standard

isibility: Beginner

Streamable: True

Device Control Dialog Box
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Continuous Mode

This mode allows you to acquire images continuously and is the default mode for most external frame

grabbers.

Multiframe Mode

This mode allows you to acquire a fixed number of images. To configure the number of images, set the

CL-U3’s AcquisitionControl > AcquisitionFrameCount feature.

You can set the AcquisitionControl > AcquisitionFrameCount feature in the Device Control dialog box,

as shown in the following image.

*

Frame Grabber Control

E‘:E Wisibility | Beginner w x

DeviceControl
ImageFormatControl

1= AcquisitionControl

Acquisitiontode Conkinuous

AcquisitionFrameToSkip u] L\\)

EventControl
TransportLayerControl

UserSetControl

ixelBusInterfaceControl

PORTEngine

CameralLinkInterfaceControl

Acquisition Frame Count ~
Mumber of frames to acquire in MulktiFrame Acquisition mode,

Min: 1 Max: 255
Increment: 1

Feature Mame: AcquisitionFrameCount

Type: Integer

Mame Space: Standard

isibility: Beginner v

SingleFrame Mode

This mode allows you to acquire a single image.
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Recording and Retrieving Images in the Onboard Memory

The recording acquisition modes allow you to capture images from a camera and store them in the
CL-U3’s onboard memory.

The readout acquisition modes allow images to be acquired from the CL-U3’s memory at a slower rate,

ensuring images are not lost.

These modes are helpful when you are working with a camera that transmits images at a rate that exceeds
the connection between the CL-U3 and the computer, resulting in dropped images. For example, a Base
Configuration Camera Link camera transmits images at up to 2.04 Gbps (2 taps of 12 bits) but the
connection to the computer might be only 1 Gbps. By using the recording and readout modes in this
example, you can capture and stream images from the camera without losing any images (as long as there

is space in the onboard memory).

While a Medium configuration Camera Link camera can transmit images at up to 4.08 Gbps, it is limited
by the USB 3.0 connection, which is approximately 3 Gbps.

The recording acquisition modes support back-to-back recording, which allows you to click the Stop and

Play buttons multiple consecutive times without clearing the onboard memory.

Acquisition starts when the Play button is pressed (the AcquisitionStart command is executed) when one

of the recording modes is selected.

Images can be stored in the CL-U3’s onboard memory as long as there is space or until there are 512
images in memory. For information about calculating how many images you can store, see “Calculating

How Many Images Can be Stored in Onboard Memory” on page 68.

If the USB cable is disconnected, or if the computer is restarted, all captured images will be lost.

ContinuousRecording Mode

With this mode, images are acquired continuously and are stored in the CL-U3’s onboard memory until
the memory is full (or 512 images are stored in onboard memory). When this limit is reached, the

CL-U3 stops acquiring new images from the camera.

We recommend that you observe AcquisitionControl > BlockBufferCount (Expert or Guru visibility
level is required). When the value for this feature stops increasing, the memory is full. For information
about the actions that clear the images from onboard memory, see “Understanding When Images are

Removed from the Onboard Memory” on page 68.

. To determine how many images can be stored in memory, see “Calculating How Many Images Can be
lE’ Stored in Onboard Memory” on page 68.
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ContinuousReadout Mode

With this mode, images are continuously read (and removed) from the CL-U3’s onboard memory. The
readout begins at the first image in memory. To see the number of images stored in onboard memory, see
AcquisitionControl > BlockBufferCount in the Device Control dialog box (Expert or Guru visibility

level is required).

Readout continues until the Stop button is pressed (AcquisitionStop command is executed) or until the

last image has been sent by the device (BlockBufferCount will be 0).

MultiFrameRecording Mode

With this mode, a fixed number of images are stored in the CL-U3’s onboard memory. To configure the
number of images, set the AcquisitionControl > AcquisitionFrameCount feature in the Device Control

dialog box. Images can be read out from memory using ContinuousReadout mode.

A maximum of 512 images can be acquired at one time in MultiFrameRecording mode.

v

7> To determine how many images can be stored in memory, see “Calculating How Many Images Can be
M Stored in Onboard Memory” on page 68.

If AcquisitionControl > AcquisitionFrameCount is set to a value that exceeds the amount of available
memory, the CL-U3 stops acquiring new images when the onboard memory is full (or 512 images are

stored in onboard memory).

BlockBufferCount shows the number of images currently in memory. In MultiFrameRecording mode,
this number is cumulative: If the memory is empty and you acquire an image, BlockBufferCount will
match the AcquisitionFrameCount. If you stop and restart recording, BlockBufferCount will increment
(to a maximum of 512 images, depending on the image size) and will no longer match the

AcquisitionFrameCount.

For information about the actions that clear the images from onboard memory, see “ContinuousReadout

Mode” on page 67.

SingleFrameRecording Mode

With this mode, a single image is saved in the CL-U3’s onboard memory after each AcquisitionStart

command.

For information about the actions that clear the images from onboard memory, see “Understanding

When Images are Removed from the Onboard Memory” on page 68.

SingleFrameReadout Mode

With this mode, a single image is acquired from the CL-U3’s onboard memory.
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Understanding When Images are Removed from the Onboard Memory
The following actions remove the images from the CL-U3’s onboard memory:

* Streaming images from the onboard memory using one of the readout acquisition modes
(ContinuousReadout or SingleFrameReadout).

* Power cycling the CL-U3, which clears all images from the onboard memory.

 Making any of the following AcquisitionMode changes and then clicking the Play button
(AcquisitionStart command):

Table 30: Changes that Clear Images from the Onboard Memory

First you acquire images with... And then you change the Acquisition mode to...

ContinuousRecording, MultiFrameRecording, or Continuous, MultiFrame, or SingleFrame
SingleFrameRecording

SingleFrameReadout or ContinuousReadout SingleFrame, MultiFrame, or Continuous

SingleFrameReadout or ContinuousReadout ContinuousRecording, MultiFrameRecording, or
SingleFrameRecording

Calculating How Many Images Can be Stored in Onboard Memory

First, take note of the PayloadSize, which appears under TransportLayerControl in the Device Control

dialog box. Expert or Guru visibility level is required to access this feature.

The PayloadSize is automatically calculated by the CL-U3 based on the selected image settings, which
include Width, Height, OffsetX, OffsetY, PixelSize, any chunk data, as well as any padding that has to be
added to the image payload.

For example, for a CL-U3 configured to use Mono10p with images that are 1920 x 1080, the PayloadSize
is equal to 2 592 000 bytes per image or 2.472 MB (2 592 000 / 1 048 576).

You can use the following equation to determine the number of images that can be saved in onboard

memory:

Available onboard memory MB / PayloadSize MB = Number of images that can be saved

Using our example, the equation is:

120 MB / 2.472 MB = 48 images

Implementing the eBUS SDK

You can create your own image acquisition software for the CL-U3. Consult the following guides for

information about creating custom image acquisition software:

o ¢BUS SDK API Quick Start Guides, available for C++, NET, Linux, and macOS, which are available
on the Pleora Support Center at supportcenter.pleora.com.

 eBUS SDK API Help Files, which are installed on your computer during the installation of the eBUS
SDK. You can access this documentation from the Windows Start menu under eBUS SDK.
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Chapter 9

Saving eBUS Player and CL-U3 Settings

This chapter describes the various ways to save your eBUS Player and CL-U3 settings.

v The changes that you make to your CL-U3 are temporary and WILL NOT PERSIST ACROSS POWER CYCLES

unless you save the changes to the flash memory of the CL-U3 or to a .pvcfg file on your computer.

The following topics are covered in this chapter:

* “Choosing the Best Method for Saving eBUS Player and CL-U3 Settings” on page 70
+ “Using File > Save” on page 72

» “Using Tools > Save Preferences” on page 72

 “Using User Sets: Saving Settings to the CL-U3’s Flash Memory” on page 73

* “Ensuring Configuration Settings are not Overwritten” on page 74

+ “Saving the CL-U3 XML File to your Computer” on page 74

Saving eBUS Player and CL-U3 Settings
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Choosing the Best Method for Saving eBUS Player and CL-U3

Settings

eBUS Player offers several ways to save your eBUS Player and CL-U3 settings. Each method saves different settings, as

outlined in the following table.

Table 31: eBUS Player and CL-U3 Settings Saving Options

Default USB 3.0 host-side communication
parameters.

These parameters are set using the Default
USB3 Vision Communication Parameters
dialog box, accessed from the Tools menu in
eBUS Player.

Format and location of saved settings:

Saves to a .pvcfg file on
your computer

Saves to your
computer’s user profile

Saves to the CL-U3
flash memory

eBUS Player procedure for saving:

File > Save

Tools > Save
preferences

Yes

Device Control >
Usersets

Settings saved:

No

These parameters are set using the
Communication Control dialog box (click the
Communication control button on the main
page of eBUS Player).

USB 3.0 host-side communication parameters.

Yes

CL-U3 parameters.

These parameters are set using the Device
Control dialog box (click the Device control
button on the main page of eBUS Player).

Image stream parameters.

These parameters are set using the Image
Stream Control dialog box (click the Image
stream control button on the main page of
eBUS Player).
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Table 31: eBUS Player and CL-U3 Settings Saving Options (Continued)

Format and location of saved settings:

Saves to a .pvcfg file on Saves to your Saves to the CL-U3
your computer computer’s user profile flash memory
eBUS Player procedure for saving:
. Tools > Save Device Control >
File > Save
preferences Usersets
Settings saved:
1. eBUS Player settings accessed from the Yes Yes No
Tools menu:
*  Setup: eBUS Player role and stream
destination
* Image filtering
* Image saving
*  Event monitor
« Buffer options
* Display options
2. GenlCam browser settings configured using
the Device Control dialog box: Parameter
visibility level, browser options, expanded or
collapsed feature lists.
Serial communication bridge settings. Yes No No
These parameters are set using the Serial
Communications Bridge dialog box, accessed
from the Tools menu.
Camera bridge configuration settings. Yes Yes No
Identification (GUID) of devices towhichyouare | Yes No No
connected.
CL-U3 serial communication settings. No No No
These parameters are set using the Device
Serial Communication dialog box accessed
from the Tools menu.

2 For more information about the settings and parameters shown in the table above, see the eBUS Player For Windows and
=0 Linux User Guide.
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Using File > Save

When you select Save As on the eBUS Player File menu, the changes you have made to the eBUS Player
application settings, along with most of the settings configured on the CL-U3 to which eBUS Player is
connected, are saved to a .pvcfg file on your computer. When you are next connected to the CL-U3 using

eBUS Player, you can apply the saved .pvcfg file to restore all of your previously configured settings.

The settings saved to the .pvcfg file include the GUID of the connected CL-U3. This enables you to
connect to the device automatically and restore the CL-U3 and eBUS Player application settings. For
more information about the eBUS Player settings saved using this method, see “eBUS Player and CL-U3
Settings Saving Options” on page 70.

To save CL-U3 settings to a .pvcfg file on your computer

1. After you have changed settings on the CL-U3 using eBUS Player, click File > Save As.

2. Choose a file name and location on your computer to save the .pvcfg file.
3. Click Save.

To apply a saved .pvcfg file to the CL-U3

1. Connect to the CL-U3 using eBUS Player.
2. Click File > Open.
3. Navigate to the saved .pvcfg file and click Open.

A You can apply the settings in the saved .pvcfg file to a CL-U3 with a different GUID.

Using Tools > Save Preferences

When you select Save Preferences on the eBUS Player Tools menu, specific eBUS Player application
settings along with Communication control options, such as a specific heartbeat interval and answer
timeout value, are saved to your Windows/Linux/macOS operating system user profile. When you next
open eBUS Player, your preferences are the same as when you closed the application. For more
information about the eBUS Player settings saved using this method, see “eBUS Player and CL-U3
Settings Saving Options” on page 70.

» The Device control settings and the Image stream control settings are not saved when you click Save
=} Preferences.
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To save eBUS Player preferences

e Click Tools > Save Preferences.

The eBUS Player preferences, including the Communication control options such as a specific
heartbeat interval and answer timeout value, are saved.

To restore default eBUS Player settings

» Click Tools > Restore Default Preferences.

Settings are restored to the values set on the CL-U3 before it was first used.

Using User Sets: Saving Settings to the CL-U3’s Flash
Memory

When you use the UserSetSave feature available in the UserSetControl section of the eBUS Player Device
Control dialog box, you are saving configuration changes to the flash memory of the CL-U3. These
settings persist across power cycles. A User Set can be configured to be the default settings for the CL-U3
so that each time you start the CL-U3 it starts with these settings applied, or you can start the CL-U3
and then apply User Set configurations.

Most Pleora external frame grabbers support two User Sets: UserSetl, which consists of the user-
configured settings, and Default, which consists of the pre-configured settings, to which you can always

revert. Settings identified as Default in the Device Control dialog box cannot be changed.
Not all CL-U3 configuration changes can be saved to a User Set. Features in the Device Control dialog box

V that can be saved to the CL-U3’s flash memory have Streamable: True in the Help section at the bottom of
the Device Control dialog box.

The following table describes the options available in UserSetControl.

Table 32: Saving Configuration Settings to the CL-U3

Setting Description

UserSetSelector Selects the User Set to load or save.
UserSetLoad Loads the User Set (specified by UserSetSelector) to the CL-U3 and makes it active.
UserSetSave Saves configuration data to the User Set specified by UserSetSelector, which is part of

the non-volatile memory of the CL-U3.

UserSetDefaultSelector Specifies the User Set to load and make active when the CL-U3 is reset or power-cycled.

UserSetLoadLastUserSet | Shows the last User Set executed by the CL-U3 from a UserSetLoad command, or as a
result of a reset (or power cycle) of the CL-U3.

UserSetLoadStatus Indicates the success or failure of the last User Set applied. The User Set can be
applied through a power cycle or through user selection.
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To save a configuration change to UserSetl

1. In the Device Control dialog box, make the required configuration changes.
2. Under UserSetControl, change the UserSetSelector setting to UserSetl.
3. Click UserSetSave.

To load the default configuration settings (one-time)

1. In the UserSetControl section of the Device Control dialog box, select Default in the
UserSetSelector box.

2. Click the UserSetLoad setting and then click the UserSetLoad button that appears to the right.
The default settings are applied to the CL-U3.

To specify the persistent settings that are loaded every time the CL-U3 is reset

* In the UserSetControl section of the Device Control dialog box, select a User Set in the
UserSetDefaultSelector box and then close the Device Control dialog box.

The next time the CL-U3 is reset or power cycled, the User Set that you selected is loaded.

Ensuring Configuration Settings are not Overwritten

When you choose a method to save eBUS Player and CL-U3 settings, you could overwrite previously

configured settings. You should consider the following when saving settings.

* Each newly applied .pvcfg file overwrites all settings configured by a previously applied .pvcfg file.
* Each newly applied .pvcfg file overwrites the settings from a previously applied User Set.

¢ When you apply CL-U3 settings from a User Set, device settings configured by a previously applied

.pvcfg are overwritten.

Saving the CL-U3 XML File to your Computer

You can save the CL-U3 XML file to your computer.

This allows you to view the CL-U3’s GenlCam XML file; it does not save your eBUS Player or camera settings.

To save your camera’s XML file

1. Click Tools > Save GenICam XML.
2. Navigate to the location in which you want to save the XML file.
Click Save.
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Chapter 10

System Troubleshooting

&

This chapter provides you with troubleshooting tips and recommended solutions for issues that can occur
during configuration, setup, and operation of the CL-U3. It also shows you how to switch between the

backup and main firmware loads.

Not all scenarios and solutions are listed here. You can refer to the Pleora Technologies Support Center at
supportcenter.pleora.com for additional support and assistance. Details for creating a customer account
are available on the Pleora Technologies Support Center.

», Refertothe product release notes that are available on the Pleora Technologies Support Center for known

issues and other product features.

Troubleshooting Tips

The scenarios and known issues listed in this chapter are those that you might encounter during the setup
and operation of your CL-U3. Not all possible scenarios and errors are presented. The symptoms, possible

causes, and resolutions depend upon your particular setup and operation.

If you perform the resolution for your issue and the issue is not corrected, we recommend you review the

U other resolutions listed in this table. Some symptoms may be interrelated.
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Table 33: Troubleshooting Tips
Symptom

When selecting the CL-U3 for
connection, the Speed (in the
Device Selection dialog box in
eBUS Player) says High instead of

a% ol iPORT-CL-US-FT03-CLOUPO3S-128x

i PORT NTx-U3-PTO3-PEOUPO1-128:xU

Speed High

Possible cause

The CL-U3 is connected to a
USB 2.0 port on your

computer, nota USB 3.0 port.

Resolution

Connect the CL-U3 to a USB 3.0 port on
your computer.

Super, and a warning icon appears.

The USB 3.0 port may have
experienced a power surge.

Troubleshoot the USB 3.0 port in your
computer by:

* Connecting the CL-U3 to another USB
3.0 port on your computer.

* Disconnecting the CL-U3 from the
computer and rebooting the
computer.

When you connect the CL-U3 to a
USB port on your computer, a
Windows warning appears,
indicating that the driver could not
be installed.

The Pleora USB3 Vision driver
is not installed on your
computer.

Install the Pleora USB3 Vision driver on
your computer using the eBUS Driver
Installation Tool (Start > All Programs >
eBUS SDK > eBUS Driver Installation
Tool).

When selecting the CL-U3 for
connection, the License field (in the
Device Selection dialog box in
eBUS Player) says Unavailable.
Resolve other errors. And the
Pleora Driver Installed field says
Unknown.

|"U iPORT-CL-U3-PT03-CLOUPO3-128xU |

Unavailable,

| Pleora Driver Installed m

The Pleora USB3 Vision driver
is not installed on your
computer.

Install the Pleora USB3 Vision driver on
your computer using the eBUS Driver
Installation Tool.
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Table 33: Troubleshooting Tips (Continued)

Symptom

The License field (in the Device
Selection dialog box in eBUS
Player) says Invalid.

Unavailable

| Power Ensure correck power, I

The CL-U3 appears in the Device
Selection dialog box in eBUS Player
but you cannot connect to it.

Possible cause

The Pleora USB3 Vision driver
is not installed, or not
installed correctly on your
computer.

Resolution

Install the Pleora USB3 Vision driver on
your computer using the eBUS Driver
Installation Tool.

If you have a third-party USB3
Vision driver on your
computer, that driver may be
interfering with the Pleora
USB3 Vision driver’s ability to
recognize the CL-U3.

Uninstall the third-party driver and install
the Pleora USB3 Vision driver on your
computer using the eBUS Driver
Installation Tool.

For the industrial models, the
CL-U3 may have been
connected to the USB port
before it was connected to
the external power supply.

Disconnect the CL-U3 from the USB port.
Connect itto an external power supply and
then reconnect it to the USB port.

For the industrial models,
external power is not being
supplied to the CL-U3.

Disconnect the CL-U3 from the USB port.
Connectitto an external power supply and
then reconnect it to the USB port.

The USB host controller is
shared, resulting in an
inadequate power supply.

Disconnect devices from your USB hub
that are drawing power from the USB hub.

The License field (in the Device
Selection dialog box in eBUS
Player) says Unlicensed.
Watermark, limited use.

Unlicensed. Watermark, limited use

A Pleora watermark appears on
transmitted and received images.

Your camera does not use
Pleora’s technology for device
control and to transmit and
receive images.

Purchase a Pleora eBUS SDK USB3 Vision
Receiver license to license the camera
and remove the watermark. For more
information, visit www.pleora.com/
products/ebus-sdk.

Image errors appear as soon as you
click Play and images do not
stream.

The CL-U3 settings may not
match the configuration of
the image data that is being
received from the camera.

Ensure the following CL-U3 settings match
the configuration of the image data from
the camera:

¢ DeviceScanType

* SensorDigitizationTaps
* PixelFormat

*  Width

+  Height

Images do not appear and the
image count (located beside
Stream at the bottom of eBUS
Player) does not increase when you
click Play.

The test pattern is off.

Turn the test pattern on.

No video source is available.

Connect a video source and ensure that
PixelBuslInterfaceControl >
PixelBusClockPresent is True.

System Troubleshooting
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Table 33: Troubleshooting Tips (Continued)

Symptom

Dropped images, dropped
connection, or failure to connect to
the CL-U3.

Possible cause

The power supply from the
USB port may be inadequate

For the standard models, the
power supply from the USB
port may be inadequate.

Resolution

Ensure 900 mA is available from the USB
port. For more information, see “Powering
the CL-U3” on page 26.

After resetting the CL-U3 using the
DeviceReset feature in eBUS Player
and then trying to reconnect to the
CL-U3, the error message
“ABORTED. Error reading manifest
table address.” appears and you
cannot connect to the CL-U3.

You tried to connect to the
CL-U3toosoon after usingthe
DeviceReset feature.

Wait at least ten seconds before you
attempt to reconnect to the CL-U3 after
using the DeviceReset feature.

Changing to the Backup Firmware Load

In the event that the main firmware load fails to start, the CL-U3 will start up using the backup firmware

load when it is restarted or power cycled.

In the rare event that the backup load is not used automatically (as indicated by the fact that eBUS Player

will not be able to detect the CL-U3), you can use the slide switch to change to the backup load.

After the CL-U3 starts up using the backup load, you can apply a firmware update to the CL-U3 to

recover the main load. For more information see the Updating Pleora Firmware knowledge base article on

the Pleora Support Center (supportcenter.pleora.com).

SW1 Slide Switch

Main load position (OFF) —
Backup load position (ON) —

FPGA Board (Back View)
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Chapter 11

Reference: Mechanical Drawings and Material List

This chapter provides mechanical drawings and also provides a list of connectors with corresponding

manufacturer details.

Three-dimensional (3-D) mechanical models are available at the Pleora Technologies Support Center.

v

The following topics are covered in this chapter:

¢ “Mechanical Drawings” on page 80
« “Enclosed Models” on page 80
» “CL-U3B-IND OEM Board Set” on page 82
+ “CL-U3M-IND OEM Board Set” on page 85
e “GPIO Board Assembly” on page 88
» “Material List” on page 90
+ “Using USB3 Vision Locking Cables with the Inverted Micro-B USB 3.0 Connector” on page 90
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Mechanical Drawings

The mechanical drawings in this section provide the CL-U3’s dimensions, features, and attributes. All

dimensions are in millimeters. Connectors are dimensioned to the center.

7 The drawings in this section include all connectors that could be present on any CL-U3. Because there are
=l different CL-U3 models, your device may not have all of the connectors shown in this chapter.

Enclosed Models

Figure 5: Enclosed Model — Camera Link Camera Side
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Figure 7: Enclosed Model — Top View
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CL-U3B-IND OEM Board Set

Figure 9: iPORT CL-U3B-IND OEM Board Set
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Figure 11: iPORT CL-U3B-IND OEM Board Set
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Figure 13: iPORT CL-U3B-IND OEM Board Set
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CL-U3M-IND OEM Board Set

Figure 14: iPORT CL-U3M-IND OEM Board Set

HT =2.60 HT = 2.60

MAXIMU
COMPONENT HEIGHT
2.1mm ON
SECONDARY SIDE

USB PHY Board

Figure 15: iPORT CL-U3M-IND OEM Board Set

HT =4.87

2 PLACES

HT =3.50

Reference: Mechanical Drawings and Material List

85



Figure 16: iPORT CL-U3M-IND OEM Board Set
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Figure 18: iPORT CL-U3M-IND OEM Board Set
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GPIO Board Assembly

Figure 19: GPIO Board — Front and Back Views

Figure 20: GPIO Board — Dimensions
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Figure 21: GPIO Board — Dimensions (Continued)

Figure 22: GPIO Board — Side Views

Reference: Mechanical Drawings and Material List
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Material List

The connector summaries for the CL-U3 are listed in the following table.

Table 34: Connector Summary

Description Manufacturer part number Manufacturer
Micro-B USB 3.0 connector 897-10-010-00-300002 Mill-Max Mfg. Corp.
12-pin circular connector HR10A-10R-12PB(71) Hirose Electric Co. Ltd.
Miniature Camera Link 12226-1100-00FR 3M

A Source manufacturer, description, and identification may vary for each connector.
[

Using USB3 Vision Locking Cables with the Inverted Micro-B
USB 3.0 Connector

The CL-U3 uses a USB 3.0 Micro-B connector in an inverted configuration, which affects use with cables
that right-angled USB 3.0 Micro-B connectors. The following table provides guidance for selecting the
appropriate cable.

Right

|

Table 35: USB3 Vision Locking Cables Orientation on CL-U3

Desired cable exit angle Cable type to use

Up Right-Angle Down
Down Right-Angle Up
Right Right-Angle Left
Left Right-Angle Right
Straight Straight
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Chapter 12

Appendix: Timing for Camera Link Base/Medium
Signals

The output of the camera must match the format of the CL-U3. You should select a case for your
application and then refer to “Timing Values for All Cases” on page 95. The stated timing restrictions are

minimum values.
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Camera Link Signals

Case 1: FVAL and LVAL are Level-Sensitive
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Case 2: FVAL and LVAL are Edge-Sensitive
In this case, FVAL and LVAL are edge-sensitive.

* Start of frame/line is signaled by: A rising (or falling) edge on FVAL, which signals the start of a
Sframe. A rising (or falling) edge on LVAL, which signals the start of a /ine.

¢ End of frame is signaled by:
 The next FVAL valid edge (rising edge when rising-edge sensitive or falling edge when falling-

edge sensitive) occurs.

* Or, when all of the pixels have been acquired (as set in the image height and width settings)
AND an end-of-frame (EOF) occurs.
Note: EOF occurs at LVAL rising edge (when rising-edge sensitive) or LVAL falling edge (when
falling-edge sensitive). This is an additional LVAL edge, in addition to the configured/expected
number of lines. See the EOF indicator in the illustration below.

* Line Missing status and Partial Line Missing errors: Partial Line Missing indicates lines are ending
early (the next LVAL valid edge occurs before all of the pixels have been acquired). Full Line Missing
indicates that the frame is ending early (the next FVAL edge occurs before all of the lines have been

acquired).
‘4 trvor
‘ 1 >
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Case 3: FVAL is Edge-Sensitive and LVAL is Level-Sensitive
In this case, FVAL is edge-sensitive and LVAL is level-sensitive.
* Start of frame/line is signaled by: A rising (or falling) edge on FVAL, which signals start of frame.
The line is valid when LVAL is active (high or low depending on settings).
* End of frame is signaled by:

 The next FVAL valid edge (rising edge when rising-edge sensitive or falling edge when falling-
edge sensitive) occurs.

* Or when all of the lines have been acquired (as set in the image height settings) AND the last
LVAL with valid data is de-asserted (low when high level sensitive or high when low level

sensitive).
* Line Missing status or a Partial Line Missing error generated:

« Full Line Missing indicates that the frame is ending early (the next FVAL edge occurs before all
of the lines have been acquired). Partial Line Missing indicates that lines are ending early (in
this case, LVAL is de-asserted before all pixels in a line are captured).
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Timing Values for All Cases

The timing values stated in the following table are minimum values only.

Table 36: Timing Values for All Cases

Case 1 Case 2 Case 3
(level) (edge) (both)

(tcp) (tcp) (tcp)
FVAL valid LVAL valid @ tFV2LV 0ob 0 1
FVAL valid Data valid &, ¢, d tFV2DV 0b 16
LVAL valid Data valid a, ¢, d tLv2Dv 0 1 0
LVAL valid LVAL invalid a tLV2LI 1 1 1
LVAL invalid LVAL valid a tLi2Lv 1 1 1
LVAL invalid Data valid a, ¢, d tLI2DV 1 N/A 1
(Automatic Internal
Retrigger disabled)
LVAL invalid Data valid tLI2DV 16 N/A 16
(Automatic Internal
Re-trigger enabled)
Data invalid LVAL invalida,c,d | tDI2LI 0 N/A 0
LVAL invalid FVAL invalid a tLI2FI Oe N/A N/A
Data invalid FVAL invalid a,c,d | tDI2FI Oe N/A N/A
FVAL invalid FVAL valid @ tFI2FV 1 1 1
FVAL invalid Data valid a,¢, d tF12DV 1 N/A N/A
Last LVAL invalid Data valid tLLI2DV 16 N/A 16
FVAL valid FVAL invalid tFV2F 16 1 1
FVAL valid FVAL valid 2FV2FV 17 17 17

a. The valid state of FVAL and LVAL is high when they are set as level-high sensitive or rising-edge
sensitive. Their valid state is low when they are set as level-low sensitive or falling-edge sensitive.

b. If LVAL is valid before FVAL becomes valid, the grabber drops the full line.
c. Data valid is defined by FVAL valid (note a), LVAL valid (note a), and DVAL valid (note d).

d. The valid state of DVAL is high when it is set as level-high sensitive, and low when set as level-low
sensitive. DVAL is always valid in the grabber when the parameter PixelBusDataValidEnabled is
off.

e. If FVAL becomes invalid and LVAL is still valid, the line is truncated.
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Chapter 13

Reference: Mean Time Between Failures (MTBF) Data

The following table provides MTBF data.

Table 37: MTBF Data

Model MTBF @ 40°C

CL-U3B External Frame Grabber 1,135,333 hours
CL-U3M External Frame Grabber

CL-U3B-IND External Frame Grabber 958,332 hours
CL-U3M-IND External Frame Grabber

Assumptions:
1. The calculation is performed using the RelCalc for Windows V5.1-TELC3 software, which
implements Telcordia SR-332 (Issue 3) failure rate models.

2. The operating internal chassis temperature is 40°C. The calculation assumes the temperature across
the boards is relatively constant.

3. The Telcordia environment is GB.
4. FEach part’s operating current/voltage/power stress is 50%.

5. The typical operating power value (as specified in the component’s datasheet) is used for each IC
and semiconductor.

6. The calculation uses the 90% UCL (Upper Confidence Level) Telcordia Issue 3 model.
7. Each part’s Telcordia Quality Level is I.
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Chapter 14

Reference: Regulatory Statements

This chapter provides regulatory statements for the CL-U3, and pertain specifically to the following

products.

Table 38: CL-U3 Regulatory Statements

Order code Model

903-0007 iPORT CL-U3B External Frame Grabber
903-0008 iPORT CL-U3M External Frame Grabber
903-0009 iPORT CL-U3B-IND External Frame Grabber
903-0010 iPORT CL-U3M-IND External Frame Grabber
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United States & Canada

These devices comply with FCC Part 15 standard(s). Operation is subject to the following two

conditions:

1. This device may not cause interference.

2. This device must accept any interference, including interference that may cause undesired operation
of the device.

This equipment has been tested and found to comply with the limits for a Class B digital device, pursuant
to part 15 of the FCC Rules. These limits are designed to provide reasonable protection against harmful
interference in a residential installation. This equipment generates, uses, and can radiate radio frequency
energy and, if not installed and used in accordance with the instructions, may cause harmful interference
to radio communications. However, there is no guarantee that interference will not occur in a particular
installation. If this equipment does cause harmful interference to radio or television reception, which can
be determined by turning the equipment off and on, the user is encouraged to try to correct the

interference by one or more of the following measures:

* Reorient or relocate the receiving antenna.
o Increase the separation between the equipment and receiver.

+ Connect the equipment into an outlet on a circuit different from that to which the receiver is
connected.

¢ Consult the dealer or an experienced radio/TV technician for help.
Changes or modifications not expressly approved by the party responsible for compliance could void the
user's authority to operate the equipment.

CAN ICES-3 (B)/NMB-3(B) - This Class B Digital Apparatus Complies with Canadian ICES-003.

Cet Appareil numerique de la classe (B) est conforme a la norme NMB-003 du Canada.

European Union

These devices comply to the EC directive 2014/30/EC - Electromagnetic Compatibility Directive under
Class B ITE equipment. They have been tested and found to comply with EN 55024:2010, EN
55032:2012/AC 2013 and EU Directive 2011/65/EU.

These are Class B products. In a domestic environment, these products may cause radio interference; in
YV this case, the user may be required to take adequate measures.
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Chapter 15

Technical Support

On the Pleora Support Center, you can:

* Download the latest software and firmware.

* Log a support issue.

* View documentation for current and past releases.

* Browse for solutions to problems other customers have encountered.

* Read knowledge base articles for information about common tasks.

To visit the Pleora Support Center

e Goto supportcenter.pleora.com.

Most material is available without logging in to a Support Center account. To access software and
firmware downloads, in addition to other content, log in to the Support Center. If you do not have
an account, click Request Account.

Accounts are usually validated within one business day.

Technical Support 101
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